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1.0 Scope 
The Users Manual (UM) for Aircraft Inventory and Readiness Reporting System (AIRRS) 
records the planning and engineering information created during the development process. The 
UM describes how to use the software system for its intended purpose and directs the user’s 
attention to various portions of the document that are applicable to the user’s specific function. 
 
1.1  Identification 
This document describes the AIRRS application, Version 4.29. 
 
1.2 System Overview 
The purpose of AIRRS is to satisfy the requirement for up-to-date aircraft inventory, readiness 
data, and flight/utilization data for each aircraft in the Navy inventory. The AIRRS application 
takes advantage of automated system investments to eliminate costly message and manual 
reporting systems by providing on-line access to aircraft inventory, readiness, and flight 
utilization data stored in the Integrated Data Environment (IDE). 
 
AIRRS provides receipt and input capabilities for the information stored uniquely for AIRRS. It 
also accesses information stored by other applications that support AIRRS functions. 
 
AIRRS uses the following categories of information to perform its function. 
 
• Inventory data provides detailed information on each individual aircraft in the Navy 

inventory such as Aircraft Controlling Custodian (ACC), Reporting Custodian, physical 
custodian (if different from reporting custodian), status, operating service life, engineering 
service life, hours in life, age distribution, and predicted retirement date based on various 
factors (e.g., operating service life, engineering service life, average utilization). 

• Readiness data includes the Subsystem Capability and Impact Reporting data, tracking hours 
reported as Full Mission Capable (FMC), Mission Capable (MC), Partially Mission Capable 
(PMC), and Not Mission Capable (NMC) for each aircraft in the inventory. 

• Flight/utilization data for aircraft and flight simulators are reported by the Naval Flight 
Record Subsystem (NAVFLIRS) are available via the RT79 monthly summary record as 
processed by the Aviation Maintenance and Material Management (AV3M) system. 

 
AIRRS operates in a Web-based environment with users accessing the application through 
Internet Explorer 6.0 (or higher) and communicating with the centrally located database server 
via the Naval Aviation Wide Area Network (NAVWAN). 
 
AIRRS provides on-line data access and report generation capabilities. Additionally, AIRRS 
provides ad hoc query capability allowing users to generate unique reports that are not initially 
provided by the application. 
 
The following is an overview of the features currently provided by AIRRS. Table 1 provides a 
list of the reports available in AIRRS. 
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Table 1.  AIRRS Reports 

Report Description 
Five Year Attrition The Five Year Attrition report gives the aircraft inventory over the last 5 years. 

It uses the inventory data to calculate percentages of aircraft loss from year to 
year. 

RT79 Nonreporting Units The RT79 Nonreporting Units report displays a report, which shows RT79 data 
that has not been received by AIRRS for each unit and Bureau Number 
(BUNO). Reporting requirements are established by each Type Commander 
(TYCOM) per COMNAVAIRFORINST 4790.2 series. 

QHIL Nonreporting Units The Quarterly Hours in Life Report Nonreporting Units report displays a 
report, which shows Quarterly Hrs in Life data that has not been received by 
AIRRS for each unit and BUNO. Quarterly Hrs in Life are required on a 
quarterly basis that has been established per CNAF message DTG 
080025ZSEP08. 

Change in Inventory by Quarter Displays the changes in an inventory over selected quarters. 
Class and Command Summary Shows the aircraft breakdown of OPNAVINST 5442.2 series Table 9 per the 

selection in Generalized Query Tool and orders the results by Class and 
Command. 

Class, Command and TMS 
Summary 

Shows the aircraft breakdown of OPNAVINST 5442.2 series Table 9 per the 
selection in Generalized Query Tool and orders the results by Class, 
Command, and Type/Model/Series (TMS). 

Class, Command, Unit and TMS 
Summary 

Shows the aircraft breakdown of OPNAVINST 5442.2 series Table 9 per the 
selection in Generalized Query Tool and orders the results by Class, 
Command, Unit, and TMS. 

TMS Summary Shows the aircraft breakdown of OPNAVINST 5442.2 series Table 9 per the 
selection in Generalized Query Tool and orders the results by TMS. 

Inventory by Age Displays the age of the inventory and the number of aircraft that are at a certain 
age. Aircraft in this chart that are less than 1 year old fall under the 1 year old 
category to keep the inventory accurate. 

Inventory by TMS Shows the number of aircraft that are in the inventory per the selection created 
in the Generalized Query Tool. 

Pipeline by Model (L-17) A summary report sorted and summarized by Class and TMS. The report is 
limited to Active aircraft only. Pipeline Percent = Total Pipeline/Total 
Operating. 

Pipeline by Model (L-17A) Identical to L-17, except for the capability to show a range of Fiscal Year (FY) 
quarters instead of only 1 quarter. 

Total Inventory Summary Total Inventory Summary summarizes aircraft status codes as per Table 9, 
OPNAVINST 5442.2 series. 

 
The ad hoc query tool is a query-by-example interface, which allows the user to custom design 
reports for specific uses. The user places the query criteria information into cells in a 
spreadsheet-like grid. The search engine then uses that information to select records from the 
data set that contain data in the corresponding fields conforming to the selection rules. The tool 
allows the user to pick from several different data sets. Table 2 shows the data sets currently 
available. 
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Table 2.  Available Data Sets 

Data Set Description 
AIRRS History data Contains a “Snapshot” of the Aircraft Inventory and Status at the end of each 

quarter.  
RT79 data Contains the data from all Record Type 79 records. 
XRAY/Audit data Contains the data from all Aircraft Custody Status Change Report (XRAY)/Audit 

records. 
Quarterly Hrs in Life data Contains the aircraft time since new data as reported at the end of each quarter. 
Organizations data Contains the historical and current Organization data. 
Aircraft Custody data Summarizes the custody history of all aircraft. 
Latest Aircraft Info Daily data Contains the latest posted info reported in XRAYs as of 0800 EST. 
IMC data Identifies Integrated Maintenance Concept (IMC) aircraft and its IMC 

information. 
 
Data Update and Validation 
 
• Three times daily update of receipt of XRAYs message data. 
• Validation, on-line review and correction, and posting of received XRAYs. 
• On-line input, validation, and review of Quarterly Hrs in Life entries. 
• Validation, on-line review and correction, and posting of received RT79s. 
 
System Administration 
 
• On-line management, for authorized users, of location, organization, capability goals, type 

equipment codes (TECs), addition of aircraft to the inventory, and strike list entry and 
approval. 

• On-line user help feature. 
 
Figure 1 identifies the systems that supply data to AIRRS, the types of customers who use the 
data, and the flow of data among them. 
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1.3 Document Overview 
The UM is organized by usage. Section 5.0 Getting Started is organized by toolbar order. The 
toolbar view is restricted by user role. AIRRS has four user types: 
 
• OPNAV 
• TYCOM 
• Wing 
• Fleet 
 
TYCOM and OPNAV roles have the most privileges. The Fleet role only permits viewing of 
posted records, canned reports, and input for Quarterly Hrs in Life. The Wing role has the same 
permissions as the Fleet role, but the user can enter and update XRAY, Quarterly Hours in Life, 
and RT79 records. 
 
For an understanding of frequently used acronyms and terms, refer to Section 9.0. The AIRRS 
Point of Contact (POC) is identified in Appendix A. Appendix B contains a summary of changes 
from the AIRRS Client Server. 
 
2.0 References 
For a complete list of system-wide references, refer to the Reference Document (RD) for AIRRS 
(Document Number 6141). 
 
3.0 Intended Audience 
The UM is intended for general Fleet users, system maintainers, TYCOM users, OPNAV users, 
and Wing users. This UM assumes a familiarity with a Personal Computer (PC) and the 
Windows operating system, and covers the total functionality of the AIRRS application. 
 
4.0 General Concepts and Conventions 
4.1 Data 
The IDE is an umbrella program intended to incorporate and integrate a variety of Naval 
Aviation logistics data systems into a single data repository. In the AIRRS context, a transaction 
item is an individual occurrence of one of the several AIRRS data inputs. The AIRRS software 
receives XRAYs, and RT79 records, and manual data inputs from OPNAV, TYCOMs, and Wing 
users. A transaction item is considered to be a single data input, either automated or manual, and 
each transaction item is processed per specification referenced in the COMNAVAIRFORINST 
4790.2 (series). 
 
A data element is an individual piece of data that composes a transaction item received by the 
AIRRS software (e.g., an XRAY record, consisting of numerous data elements including Serial 
Number [SERNO], Bureau Number [BUNO], ACC Command Code, Status Code, Permanent 
Unit Code [PUC], Action Date). 
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4.1.1 Data Interfaces 
The following describes the AIRRS data interfaces to other IDE applications: 
 
Data Input 
 
1. XRAYS are received asynchronously via NALCOMIS OOMA, manual input, or Naval 

message. The COMNAVAIRFORINST 4790.2 (series) is the authoritative source for XRAY 
submission. XRAY data is extracted from OOMA three times a day prior to the XRAY 
Naval messages parsing. XRAY Naval message data and (OOMA) XRAY extract are then 
passed through a validation process. XRAYs submitted via the Web application are validated 
after selecting the Save button. The Type Wings or TYCOMs correct data that fails 
validation prior to posting.  

 
2. AIRRS receives RT79 data through SALTS after the Micro AV3M system has summarized 

maintenance information into an RT79 Format. RT79 data received monthly via SALTS 
transmissions generated by local Data Services Facilities per COMNAVAIRFORINST 
4790.2 (series) is parsed and passed through validation criteria. OOMA RT79 data is 
processed and extracted monthly. Once loaded into the database, the data also passes through 
validation criteria. Valid data is immediately posted to the database. Invalid data requires 
correction by the Type Wings or TYCOMs prior to posting. 

 
3. Quarterly aircraft time since new is reported via the Web application. The time since new and 

valid XRAY data posted ‘as of’ the end of the quarter are used to generate Quarterly 
Histories data. Quarterly Histories data is static and does not change once generated. It is 
viewable through the Inventory Reports menu selection. 

 
4. The TYCOMs have final approval authority on the validity of the XRAY, Quarterly Hrs in 

Life. and RT79 data. 
 
4.1.2 User Roles 
User access is controlled through roles assigned by the AIRRS system manager. User roles are 
associated with a log on userid and allow access to certain system functions, as shown in Table 
3. 

Table 3.  AIRRS User Role Definitions 

Function OPNAV NAV MASSO TYCOM Wing  Fleet DBA LRM 
Assign Local Role 
Manager 

     C, R, U, D  

Assign Local User 
Roles 

      C, R, U 

Squadron (New 
Organization Code) 

C, R C, R, U C, R     

Assign 
Squadron/Wing/ 
TYCOM 

C, R C, R, U C, R     
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Function OPNAV NAV MASSO TYCOM Wing  Fleet DBA LRM 
Wing C, R C, R, U C, R     
Capability Goals C, R C, R, U C, R     
Class C, R C, R, U C, R     
Subclass C, R C, R, U C, R     
Commands C, R C, R, U C, R     
BUNOs, add to 
inventory 

C C, R, U      

TEC TM  C, R C, R, U      
TEC TMS  C, R C, R, U      
TEC Engines C, R C, R, U      
TEC Training C, R C, R, U      
TEC TMS/Mfg Parts C, R C, R, U      
TEC Life Limits C, R C, R, U      
Location Names/ 
Variations 

C, R C, R, U C, R     

Organization 
Names/ 
Variations 

C, R C, R, U C, R     

BUNO Special 
Characteristics 

 C, R, U C, R     

Strike Authorizations C, R, U  C, R, U     
XRAYs   C, R, U, L, O C, R, U    
Quarterly Hrs in Life   C, R, U, L, O C, R, U C, R, U   
RT79s   C, R, U, L, O C, R, U    
IMC Data   C, R     
Reports R R R R R R  
Key:  C = Create D = Delete R = Read U = Update L = Logical Delete  O = Override Errors 
 
5.0 Getting Started 
5.1 System Requirements 
AIRRS operates in a Web-based environment in which users access the application through 
Internet Explorer 6.0 or greater. The application communicates with the centrally located 
database server via the NAVWAN or dial-up connectivity. AIRRS provides on-line data input, 
access, and report generation capabilities, as well as an ad hoc query capability that allows users 
to generate unique reports not initially provided by the application. 
 
5.2 Applying for a Userid 
The Naval Air Systems Command (NAVAIR) System Administration Team (AIR 6.8.4) holds 
the responsibility for the security of the AIRRS application. To apply for a userid and password, 
obtain and complete an on-line registration form. 
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On-line access registration is available on the NALDA logistics home page at 
http:/www.navair.navy.mil/logisitcs. 
 
Select the SUPPORT tab at the top of the page then select ACCESS INFORMATION Link. A 
Department of Defense (DoD) Common Access Card (CAC) is required for access to the Web 
site. 
 
Assignment of userids and passwords generally takes 2 to 4 working days. Once an account has 
been established, notification will be sent via email. 
 
5.2.1 Log On 
A Department of Defense (DoD) Common Access Card (CAC) is required for access to the Web 
site. To log on to AIRRS: 
 
1. Type the AIRRS Web address, https://prdwebserv1.navair.navy.mil/airrsweb, into the IE 

6.0+ address box and click Go or press Enter. The Login Dialog Box opens. A link to the 
application can also be found at http://www.navair.navy.mil/logistics  

 

 
 

2. Enter the userid in the User Name field. Press Tab to move the cursor to the next field. 
3. Enter the Password in the Password field. Click OK, or press Enter. 
4. If the userid and password are valid, access to AIRRS is granted, with function privileges 

associated with the assigned User Role. 
 
AIRRS shows the following log on error messages for the reasons indicated: 
 
1. Error:  "An error occurred with your account when logging into the database. Please 

contact the NALDA help desk and ask them to look into your AIRRS database account."  
Cause:  Either the user does not have an Oracle account on the database or the password is 
different than the user's AIRRS password. The two passwords must match. 

2. Error:  "An error occurred while attempting to log into the database. Please contact the 
NALDA help desk." 
Cause:  The database, server, or network is down or experiencing problems. The error is 
unrelated to the user’s account. 
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5.2.2 System Messages Form 
When the AIRRS login connection process is complete, the System Messages Form opens. The 
System Messages Form contains current messages controlled by the AIRRS Project Manager. 
 

 
 

5.3 System Functions and Interactions 
AIRRS software provides a main or top-level menu containing the primary function categories. 
The menus and functions available in AIRRS are accessible according to an assigned user role. 
Menus and functions that are not available to an assigned role will not appear as options. 
 
5.4 Toolbar 
The AIRRS toolbar provides one-click access to the more commonly used system functions. The 
following illustrations show the menus for the TYCOM/Wing/OPNAV users and the Fleet users, 
respectively. 
 

 
 

 
 
5.5 File Menu 
The following illustration shows the AIRRS File Menu for TYCOM, Wing, and OPNAV users. 
 

 
 
5.5.1 Set ACC 
The Set ACC function allows the TYCOM, Wing, and OPNAV users to change their ACCs. To 
change the ACC, select File > Set ACC, select the ACC, and then click OK. 
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5.6 Edit Menu 
Options on the Edit Menu vary depending on a user’s authorized access. Users assigned a 
TYCOM role are the only users with access to the Edit Menu. TYCOM users have the ability to 
post and unpost BUNOs. 
 

 
 
5.6.1 Post BUNO 
TYCOM users have privileges to use the Post BUNO option. To post the BUNO, type in the 
BUNO and click Post BUNO. The Post BUNO function causes all unposted, valid XRAYs of the 
selected BUNO to be posted. Unposted valid XRAYs are identified with a stat_flag = ‘V’. Use 
this function if there is difficulty getting an XRAY to validate. It may not validate because the 
previous XRAY for the same BUNO may need to be POSTED. 
 

 
 
5.6.2 UnPost BUNO 
In order to process an XRAY that has been received an out of date sequence, it will be necessary 
to ‘UnPost’ a BUNOs XRAY records. To UnPost a BUNO, the TYCOM user types the BUNO 
in the UnPost Buno field and clicks Get Dates.  
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A drop-down list appears on the UnPost Buno Page, containing the posted BUNO dates. Select 
the earliest date to be unposted, and click UnPost BUNO. 
 
Note:  Do not UnPost XRAY records prior to:  19990101 

 

 
 

The page will refresh and display “Buno Unposted Successfully”. The record is viewable from 
the XRAY Summary page. 
 
5.6.3 UnPost Part 1 
To UnPost a Part 1, the TYCOM user types the PUC into the box, and clicks Get Dates. A drop-
down list will contain the posted PUC dates. Select the earliest date to be unposted, and then 
click UnPost Part 1. UnPost Part 1 has the same look and feel as the Unpost BUNO function. 
 
5.7 Processing Menu 
TYCOM and Wing users have an expanded AIRRS Processing Menu. The following 
illustrations show menu options for TYCOM users and Wing users, respectively. The Fleet Role 
Processing Menu also provides access to the Quarterly Hrs in Life input page. 
 

TYCOM View 
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Wing View 

 
 

Fleet View 

 
 
5.7.1 Processing Flag Descriptions 

 The Green flag means the particular record is in a valid or posted state. 
• Valid means the record has passed all validation but has not been posted yet. 
• Posted means the record has passed all validation and has been posted to the database. 
 

 The Red flag means the particular record is in an invalid state. 
• Invalid means the record fails validation. 
 

 The Yellow flag means the particular record is in an awaiting validation, waiting 
validation, or stat_flag ‘R’. 
• Awaiting Validation is the state in which all new records enter the database prior to 

validation. 
• Waiting Validation is the state in which the record has a prior invalid record that must be 

fixed before the record can be validated. 
• R is the state in which the record has some problems that stop the validation and 

normalization process. 
 

5.7.2 What’s New Submenu 
Set ACC as described in Section 5.4.1.1 prior to selecting any item from the What’s New 
Submenu. The following illustration shows the AIRRS Processing >What’s New Submenu for 
TYCOMs and Wings users, respectively. 
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5.7.2.1 Process Unparsed 
Selecting the Process Unparsed option retrieves the unparsed new messages. Unparsed messages 
are XRAYs received via naval message format. When the naval message does not meet the 
parser’s criteria the message is stored in the Unparsed until the format is corrected and 
resubmitted. To access the XRAY messages, double-click in the To field on the row desired. The 
following illustration shows the Unparsed Naval Msg Form. 
 

 
 
5.7.2.1.1 Update and Delete Unparsed Records 
On the Unparsed Naval Msg Detail Window, you can use the update, delete, or cancel functions. 
Error messages are located beneath the Update button. If an error in the message requires 
updating to allow the message to parse, change the message information and then click Update. 
Clicking Update refreshes the window and the updated message will no longer be visible. The 
message will be reparsed at the next scheduled message load; 0800, 1200, or 1600. 
 
To delete the record, click Delete. The window refreshes and the message is removed from the 
form. 
 
Click cancel to cancel a function. The window refreshes and the message for which the function 
was being performed remains on the Form. 
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5.7.2.2 Process XRAYs 
Selecting the Process XRAYs menu option displays the XRAY Summary for all XRAYs with a 
display state of KEEP. 
 
To sort by a field, click on the field descriptor (e.g., to sort by BUNO, click on the word 
“BUNO”).  
 
TYCOMs can clear ALL green flags on the window by clicking Clear Green Flags. TYCOMs 
may clear individual green flags by clicking an individual green flag. Clearing the Green Flags 
will set the display state to DROP so the XRAY will no longer display on the XRAY Summary. 
To access the XRAY messages, double-click on the "BUNO" field in the row desired. The 
following illustration shows the XRAY Summary Window. 
 

 
 
5.7.2.3 Process RT79s 
Selecting the Process RT79s menu option opens the RT79 Summary for all the records in an 
INVALID state. 
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To sort by a field, click on the field descriptor (e.g., to sort by BUNO, click on the word 
“BUNO”). 
 
To access the RT79s messages, double-click the "BUNO" field in the row desired. See Section 
5.7.7 for more information on the RT79s Detail Window. 
 
The following illustration shows an example of the Process RT79 Summary Window. 
 

 
 
5.7.3 XRAYS Submenu 
The following illustration shows the AIRRS Processing XRAYS Submenu. 
 

 
 
5.7.4 History 
The History function opens the same window as Reports > Ad Hoc > Create New > 
XRAYS/Audits. See Section 5.8.1 for details on the AdHoc >Create New>XRAYS/Audits 
Function. 
 
5.7.5 New 
The New function opens the XRAY Detail Window, allowing entry of new XRAYs directly into 
the system. Enter the data for the XRAY into the correct fields, and then click Save. The XRAY 
will validate. 
 
If the validation passes, a green flag appears. 
 
If a validation error occurs, a red flag appears in the upper left corner of the window and the 
invalid fields will be highlighted in red. Click to select a field highlighted in red to see a 
description of the error in the Error Message field. 
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A yellow flag indicates that the record is waiting for an earlier XRAY record (by date or order 
number) to be validated. 
 
If the XRAY was entered using the naval messaging system, you can view the original message 
by double-clicking the XRAY SEQNO box. 
 
For a description of the function of each button, see Section 6.1.1.2. The following illustration 
shows an example of the New XRAY Detail Window (no data). 
 

 
 
The following two illustrations show the TYCOM and Wing view of the XRAY Detail Window 
buttons after clicking Save. 
 

TYCOM View 

 
 

Wing View  

 
 

5.7.6 Organization Change of Location Detail  
Until a new input screen can be implemented, a workaround is in place for submitting an 
Organization Change of Location record into AIRRS. Use the XRAY Detail Page to enter the 
necessary Organization Change of Location information:  PUC, Org Code, Action Date, Op 
Status Code, Fleet Assigned Code, Unit Loc From, Unit Loc To, and Remarks. 
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In addition, enter information in the BUNO and Status Code fields. Click Save. Saving the 
record will cause an error. When you receive the error, remove the BUNO and Status Code 
information, and then click Update. Provided there are no other errors, the record will validate as 
an Organization Change Location record. 
 
5.7.7 RT79 
The following illustration shows the AIRRS Processing RT79 menu item. 
 

 
 

RT79s can be entered manually using the RT79 Detail Window (all fields must have an entry, 
even if the entry is 0, except the Correct and Away fields). The TYCOM or Wing user enters the 
data into the RT79 record, and then clicks Save. The record validates. 
 
If the validation passes, a green flag appears in the upper left portion of the window.  
 
If the validation fails, the record displays a red flag and fields are highlighted in red. Click to 
select a field highlighted in red to see a description of the error in the Error Message field. 
 
A yellow flag indicates that the record is waiting for an earlier (by date) to be validated. For a 
description of each button’s function, see Section 6.1.1.2. 
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The following illustration shows the TYCOM and Wing view of the RT79 Detail Window 
buttons after clicking Save. 
 

TYCOM View 

 
 

Wing View 

 
 
5.7.8 IMC Data 
Selecting the IMC Data option opens a window that accesses data from the table identifying IMC 
aircraft and its IMC information. Click in the BUNO field to see its detailed IMC information. 
When a BUNO is placed in IMC, click New, enter data in all fields, and click Save. Only 
TYCOM users are able to use the IMC Data Window. 
 

 
 

The following describes some of the fields on the IMC Data Window: 
 
• Type Model Series - TMS of the BUNO. 
• PED - Period End Date planned for the BUNO. 
• CV or Land - Carrier or Land basing of the aircraft determines length of IMC Fixed Service 

Period (FSP). 
• PMI Number - Number of the first PMI scheduled for the BUNO. 
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• First Phase Due - MMYY of scheduled first induction into PMI 1. 
• TYCOM - TYCOM in custody of the aircraft. 
• Baseline Op Service Months - OSM number calculated for BUNO by AIRRS based on 

delivery date and planned Period End Date. 
• Baseline Op Service Period - Operating Service Period number calculated for aircraft by 

AIRRS based on number of Modification, Corrosion, and Paint Program (MCAPP) 
inductions previously reported on XRAYs. 

• Location - Location of the aircraft. 
• PMI2 Location - Location at which Planned Maintenance Interval (PMI) 2 will take place. 
 
5.7.9 Qrtly Hours in Life 

This section explains how to use Quarterly Hours in Life and is divided into these three parts: 

Part I - Verify BUNOs Assigned to Your PUC in AIRRS 
Part II - Enter Quarterly Hours in Life (Non-TYCOM Role) 
Part III - Enter Quarterly Hours in Life (TYCOM Role) 

Message DTG Statement 

Per COMNAVAIRFOR message DTG 080025ZSEP08, reporting of Aircraft Accounting Audit 
Reports (AAARs) is no longer required. Beginning October 2008, a new requirement to report 
Aircraft Hours in Life on a quarterly schedule replaces reporting of AAARs. 

Submit Aircraft Hours in Life by the fifth of the month following each End of Quarter (EOQ) 
month:  EOQ month = December, report due January 5; EOQ month = March, report due April 
5, EOQ month = June, report due July 5; and EOQ month = September, report due October 5. 

Important!:  Before inputting Quarterly Hours in Life, ensure all XRAYs with an action code of 
"A", "F", "G", "R", or "Y" and an action date equal to (=) or less than (<) the quarter for which 
you are reporting hours are posted. 

Part I - Verify BUNOs Assigned to Your PUC in AIRRS 
1. After logging on to AIRRS, select the following menu options, beginning on the Reports 

Menu:  AdHoc>Create New>Latest Aircraft Info (Daily). See Figure 1. 
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Figure 2.  Navigating to the Adhoc Query Form - Latest Aircraft Info Daily Page 

2. When the Adhoc Query Form - Latest Aircraft Info Daily Page opens (Figure 2), click each 
of the following check boxes to enter a check mark for selecting data types. After making 
selections, click Select. (Figure 3 shows check marks for six of the seven entries.) 
(B) PUC (C) Act Date (D) Act Code Report Date 
(E) Status (A) BUNO (F) Type Model Series 

 

Figure 3.  Adhoc Query Form - Latest Aircraft Info Daily Page 

3. Clicking Select submits your data type selections. In the “query results” portion of the page, 
the system will display column headings representing your selections. See Figure 4. 

 

Data Type Column Headings

Query results 
portion of the page. 

Note 
To set the columns 
to appear every time 
you open the Adhoc 
Query Form to 
search for XRAYs, 
click Set Defaults. 
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Figure 4.  Data Type Columns Returned 

4. Enter the PUC you want to see under the B PUC column and press Enter. Figure 5 shows we 
entered “001843” for our example. 

 

001843

Figure 5.  Entering B PUC 

5. Next, click Query to execute the search for your data. The system searches for your data and 
returns it to the query results portion of the page. See Figure 6. 

  

The data returned 
reflects the posted 
XRAY data available 
per BUNO in AIRRS 
as of 0730 EST (as 
indicated by the 
Report Date). 

If the XRAY data 
shown does not 
reflect the latest 
XRAY information 
submitted, the XRAY 
status may be invalid 
or it could be valid 
but not posted. 

Figure 6.  B PUC Data Returned 
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6. To verify XRAY status, select the following menu options, beginning on the Reports Menu:  
Reports>AdHoc>Create New>XRAYs/Audits. See Figure 7. 

 

Figure 7.  Navigating to the Adhoc Query Form - XRAY/Audits Page 

7. When the Adhoc Query Form - XRAYs/Audits Page opens (Figure 8), click each of the 
following check boxes to enter a check mark for selecting data types. After making 
selections, click Select. (Figure 8 shows check marks for six of the nine entries.) 
(B) PUC (E) Acft Stat Code Stat Flag 
(C) Date of Action (A) BUNO Audit Indicator 
(D) Action Code (F) Type Model Series MSG DTG 

 

Figure 8.  Adhoc Query Form - XRAY/Audits Page 

8. Clicking Select submits your data type selections. In the “query results” portion of the page, 
the system will display column headings representing your selections. See Figure 9. 
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Data Type Column Headings

Query results 
portion of the page. 

Note 
To set the columns to
appear every time 
you open the Adhoc 
Query Form to 
search for XRAYs, 
click Set Defaults. 

Figure 9.  Data Type Columns Returned 

9. Next, you can query the data to see all XRAYs against a specific BUNO and its status. Enter 
the BUNO you want to see under the BUNO column. Figure 10 shows we entered “166845” 
for our example. You also need to type an “X” in the Audit Indicator column. This will 
ensure you will only query XRAY data, not Audit data. Press Enter after making these 
entries. 

 
Figure 10.  Entering BUNO and Audit Indicator 
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10. Next, click Query to execute the search for your data. The system searches for your data and 
returns it to the query results portion of the page (see Figure 11). 

 

STAT_FLAG Codes:  
The data returned 
is in 
“ACTION_DATE” 
order, beginning 
with the most 
recent XRAY. 

D = Deleted 
I = Invalid 
P = Posted 
V = Valid 
W = Waiting (There is 
an XRAY with a prior 
Action Date that is 
invalid.) 
 
XRAYs need to have 
a STAT_FLAG of “P” 
so the BUNO displays 
automatically when 
you enter the PUC. 

Figure 11.  BUNO Data Returned 

11. Check the STAT_FLAG column for each record returned. If an XRAY has a STAT_FLAG 
of “I” or “W” and the Action Date is equal to (=) or less than (<) the Quarterly Hours in Life 
Reporting Date, you will need to contact the Wing about correcting the XRAY before 
reporting Quarterly Hours in Life. When all XRAYs have a STAT_FLAG of “P,” you may 
enter Quarterly Hours in Life. 

a. Continue to Part II of this reference guide if you have a Non-TYCOM Role. 
b. Continue to Part III of this reference guide if you have a TYCOM role. 

Part II - Enter Quarterly Hours in Life (Non-TYCOM Role) 
1. After logging on to AIRRS, select the following menu options, beginning on the Processing 

Menu:  Processing>Qtrly Hours in Life. See Figure 12. 

 

 

Figure 12.  Navigating to the Quarterly Hours in Life Input Page 

2. When the Quarterly Hours in Life Input Page opens (Figure 13), use the following guidelines 
to make entries:  

a. The Reporting Quarter defaults to the current quarter. Accept this value. 
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b. Enter a PUC in the field next to the Submit PUC button, and then click Submit PUC. 
Figure 13 shows we entered PUC “000020”. 

 

Figure 13.  Entering and Submitting a PUC 

 
3. The Quarterly Hours in Life Page opens with BUNOs for the specified PUC (provided there 

are no invalid XRAY ACTION Codes (i.e., “A”, “F”, “G”, “R”, or “Y”). See Figure 14. 

 

Figure 14.  Understanding the Quarterly Hours in Life Page 

The page contains 
two sections showing 
the status of the 
XRAYs for the 
BUNOs associated 
with the PUC: 

The “Records 
Indicate Unposted 
XRAYs” section 
shows BUNOs that 
will need invalid 
XRAYs corrected 
and posted before 
any hours can be 
entered. Contact your 
Wing for assistance. 

If no invalid XRAYs 
exist, this section will 
not appear on the 
page. 

The “Enter Hours in 
Life for Posted 
XRAYs” section shows 
the BUNOs and hours 
associated with the 
specified PUC. 
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4. Figure 15 shows a Quarterly Hours in Life Page for PUC 000020. At this point in time, no 
invalid XRAYs exist, so only the “Enter Hours in Life for Posted XRAYs” section of the 
page displays. Enter hours in life (using tenths) for each aircraft in the Hrs in Life field to 
report the end of the Reporting Quarter (31 Dec, 31 Mar, 30 Jun, and 30 Sep) hours. After 
entering hours, click Save. 

 

Note 
If you entered a 
PUC and there 
are missing 
BUNO(s) it may 
be that the 
BUNO(s) are 
assigned to a 
detachment PUC. 
Enter the PUC of 
the detachment. 

Enter hours in life 
(using tenths) for each 
aircraft in the Hrs in 
Life field to report the 
end of the Reporting 
Quarter (31 Dec, 31 
Mar, 30 Jun, and 30 
Sep) hours. 

Figure 15.  Entering Hours in Life Updates 

5. After clicking Save, a message appears to confirm the hours you entered were saved to the 
database. See Figure 16. 

 

Any hours entered that are less than (<) the hours 
shown in the Previous Hours column will appear with 
an error indicator, as shown in this example. If the 
hours you entered are correct (even though they are 
lower), you will need to notify the Wing/TYCOM. The 
hours flagged with the error indicator have not been 
saved to the database. The responsible TYCOM will 
need to log on to AIRRS to perform an “Override” 
before the hours are saved. Part III of this reference 
guide explains TYCOM Override entries. 

Figure 16.  Confirmation Message for Reported Life in Hours Entries 

6. Click Return to PUC Entry to close this message (Figure 16) and return to the Quarterly 
Hours in Life Input Page. 
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7. When the Quarterly Hours in Life Input Page opens (Figure 17): 
a. Accept the default value in the Reporting Quarter field. 
b. Reenter the PUC 000020. Select the Submit PUC. 
 

 
Figure 17.  Reentering and Submitting the PUC 

8. The Quarterly Hours in Life Page opens with BUNOs for the specified PUC. There will be 
Update buttons located to the right of the Hours in Life column. 

 

If any hours are incorrect, 
make the change by 
replacing the current 
number of hours. Our 
example will show that we 
changed the hours for 
BUNO 166461 from 
1888.7 to 1889.7).  

Figure 18.  Updating Quarterly Hours in Life 

9. After changing a quarterly hours in life value, click the Update button to the right of the row 
for the BUNO. See Figure 18. 

10. A message appears to confirm the update and that the hours you entered were saved to the 
database. See Figure 19. 

 

This confirmation 
message shows we 
successfully changed the 
hours for BUNO 166461 
from 1888.7 to 1889.7).

Figure 19.  Update Confirmation Message 
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Part III - Enter Quarterly Hours in Life (TYCOM Role) 
The example in this scenario is designed to demonstrate how to perform an override when the 
hours entered are less than (<) those previously reported. TYCOMs would need to perform this 
procedure when notified that hours less than previously reported need to be entered into the 
database for a specific BUNO. 

1. After logging on to AIRRS, select the following menu options, beginning on the Processing 
Menu:  Processing>Qtrly Hours in Life. See Figure 20. 

 

Figure 20.  Navigating to the Quarterly Hours in Life Input Page 

2. When the Quarterly Hours in Life Input Page opens (Figure 21), use the following guidelines 
to make entries:  

c. The Reporting Quarter defaults to the current quarter. Accept this value. 
d. Enter a PUC in the field next to the Submit PUC button, and then click Submit PUC. 

Figure 21 shows we entered PUC “000020”. 

 

Figure 21.  Entering and Submitting a PUC 

3. The Quarterly Hours in Life Page opens with BUNOs for the specified PUC (provided there 
are no invalid XRAY ACTION Codes (i.e., “A”, “F”, “G”, “R”, or “Y”). See Figure 22. 
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The “Enter Hours in 
Life for Posted 
XRAYs” section 
shows the BUNOs 
and hours associated 
with the specified 
PUC. 

Figure 22.  Quarterly Hours in Life Page for Specified PUC 

 

4. Locate the BUNO for which you need to enter hours. For this example, we are using BUNO 
166462 (see Figure 22). You will first enter the previous hours for this BUNO (this is done 
so the Override button displays for the BUNO when you return to the page after saving the 
hours you enter). Figure 23 shows we entered 1792.0 hours for BUNO 166462. After 
entering hours, click Save. 

 

Note 
If you entered a 
PUC and there are 
missing BUNO(s) 
it may be that the 
BUNO(s) are 
assigned to a 
detachment PUC. 
Enter the PUC of 
the detachment. 

Enter hours in life 
(using tenths) for 
aircraft in the Hrs in 
Life field to report the 
end of the Reporting 
Quarter (31 Dec, 31 
Mar, 30 Jun, and 30 
Sep) hours. 

Figure 23.  Entering Hours in Life 

5. After clicking Save, a message appears to confirm the hours you entered were saved to the 
database. See Figure 24. 
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Figure 24.  Confirmation Message for Reported Life in Hours Entries 

6. Click Return to PUC Entry to close this message (Figure 24) and to return to the Quarterly 
Hours in Life Input Page. 

7. When the Quarterly Hours in Life Input Page opens (Figure 25): 

a. Accept the default value in the Reporting Quarter field. 
b. Re-enter the PUC (000020) n the PUC field, and click Submit PUC. 

 

Figure 25.  Reentering and submitting the PUC 

8. The Quarterly Hours in Life Page opens with BUNOs for the specified PUC. The Override 
button appears to the right of the 166462 BUNO row. See Figure 26. 
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Figure 26.  Quarterly Hours in Life Page for Specified PUC 

9. Enter new Hours in Life for the same BUNO. Our example shows we are entering 1790.2 
(these hours are less than the previously reported hours of 1792.0). After making your entry, 
click the Override button to the right of the row for BUNO 166462. See Figure 27. 

 

Figure 27.  Entering Hours in Life That Are Less Than Previously Reported Hours 

10. A message appears to confirm the override and that the hours you entered were saved to the 
database. See Figure 28. 

 

Figure 28.  Override Confirmation Message 

11. Click Return to PUC Entry to close this message (Figure 28) and to return to the Quarterly 
Hours in Life Input Page. 
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5.8 Reports Menu 
The Reports Menu contains a list of report category items, including: 
 
• Ad Hoc 
• Inventory 
• RT79 Non-reporting Units 
• Audit Non-reporting Units 
• Five Year Attrition Rate 
 

 
 
5.8.1 Reports Ad Hoc Submenu 
Use the Ad Hoc Submenu to create new queries or retrieve saved queries on the different data 
sets available for querying. Search information is entered in a spreadsheet-like grid. 
 
The Ad Hoc Query window is a query-by-example user interface to the AIRRS ad hoc query 
tool. 

  
 
5.8.1.1 Ad Hoc Query Tool 
Use the ad hoc query tool as a query by example interface to custom design reports for specific 
uses. Enter the search information into cells in a spreadsheet-like grid. The search engine then 
uses that information to select records from the data set, which contain data in the corresponding 
fields that conform to the selection rules. 
 
You can pick AIRRS History, RT79, XRAYs/Audits, Organizations, Aircraft Custody, Latest 
Aircraft Info (Daily), and IMC Data. Appendix C contains the description of the available fields 
and the corresponding column name and description for each field available in each ad hoc 
window. 
 
Note:  Fleet users only see Posted records. It is important for all other users to have the Stat Flag, 
XRAY/RT79 Seqno, and Ver Num boxes checked to avoid confusion over the validity of 
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records. All users should have the XRAY Order Number box checked to see the order of the 
records when there are multiple messages with the same action date. 
 
The Audit Indicator field is also important to avoid a mix of XRAY and Audit records. An ‘X’ in 
the field will return only XRAY data and an ‘A’ in the field would return old Aircraft 
Accounting Audit records. No specified entry in the audit indicator field will return a mix of 
XRAY and Audit records. 
 
Select the fields of the specified data set that should be shown, the order in which to display 
them, the columns in which the page breaks should be inserted, and the columns in which 
subtotals should be generated. 
 
Use the AIRRS ad hoc query capability to generate new queries and to save queries that have 
been generated in named query files. Execution of a saved query regenerates the results of the 
query based on the most current database information. The following Sections describe elements 
of using the ad hoc query tool. 
 
The Queries are limited to a maximum of 20,000 rows of data. If a query returns more than the 
maximum number of rows, a message displays to inform you to modify the filters to request 
fewer than 20,000 rows of data. 
 

 
 
5.8.1.2 Creating New Ad Hoc Queries 
Use the following steps to access the Ad Hoc Query Tool: 
 
1. Select Reports > Ad Hoc > Create New. Next, select the desired data type category from the 

menu (i.e. AIRRS History, RT 79, etc.). The Ad Hoc Query Window opens. The window is 
divided into sections. 
a. The top section of the window contains the data area, which is used to enter query 

information and to display query results. 
b. The bottom section of the window is used to make field entries. It also contains an array 

of radio buttons that represent a data field in the selected data set. 
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The following illustration describes how to access the XRAY/Audit AdHoc Query Form. 
 

 
 

The following is the Adhoc Query Form - Xrays/Audits Window. 
 

 
 
The following two illustrations show the Wing, and Fleet user views of the Adhoc Query Form 
after executing a query. 
 

Wing View 
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Fleet View 

 
 

5.8.1.2.1 Selecting/Deselecting Fields from the Data Set 
1. Select data fields by selecting radio button(s) in the bottom section of the window. Use the 

scroll bar to view information to the right or left in the window. The software displays a 
column header in the data area representing each selected field. 

2. Deselect data fields by selecting appropriate radio button(s). The columns representing 
selected fields are removed from the data area. 

3. Clicking the SELECT button will refresh the window to add or remove field selections. 
 
5.8.1.2.2 Changing Column Display Order 
When selected columns appear, depress and hold the left mouse button in the column header and 
drag the column to the desired position. 
 
5.8.1.2.3 Setting Default Ad Hoc Fields 
You can set up each Adhoc Query Form so that the same fields are retrieved each time you select 
that window. To set the default fields: 
 
1. Go to the desired Adhoc Query Form. 
2. Choose the fields to be the default. 
3. Click Select. 
4. Click Set Defaults. 
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5.8.1.2.4 Querying the Data Set 
You can query data from a selected data set based on the menu item selected to create a report. 
To query the database for the desired records: 
 
1. Enter selection criteria in the first row of the corresponding column in the data area. For 

example, enter a BUNO in the first row of the BUNO column. 
2. Enter additional selection criteria in the appropriate columns of the first row to narrow the 

search. To capture the value after entering data into a column, press ENTER or TAB 
3. To enter ‘OR’ selection criteria, click INSERT to add another ad hoc criteria line (row). 

Then enter the selection criteria and press ENTER or TAB. 
4. Submit query by clicking the Query Button. The software displays all records that 

correspond to the entered criteria in the data area. 
5. The query displays in a spreadsheet format where each row represents a record. 
 
The XRAY/Audit records initial sort will have XRAYs at the top and audits at the bottom, the 
Action Dates descending, and finally the XRAY SEQNOs descending. The RT79 records initial 
sort will have the Trans Date descending then BUNO descending. 
 
The ad hoc queries will always return the columns in alphabetical order. 
 
5.8.1.2.5 Query Selection Criteria 
You can use the following functions on the AIRRS Ad Hoc Window: 
 
• Equal to (=) 
• Greater than (>) 
• Greater than equal to (>=) 
• Less than (<) 
• Less than equal to (<=) 
• Not equal to (!=) 
• Null (is null) 
• Wildcard searches (e.g., pax%) 
• Multiple comma delimited entries (164700,164701) 
• Between two values, use the word “Between” between the lower and upper values 
• All data queried on the same line will be an ‘AND’ statement 
• All data queried on a different line will be an ‘OR’ statement 
 
All text is converted to upper case in the background for consistency. For a description of how to 
select data, see Table 4. 

Table 4.  AIRRS Ad Hoc Query Selection Criteria 

To Select Data Values: Enter: 
Equal to the search value The search value in the first row of the appropriate 

column. 
Equal to more than one search value The first search value in the first row of the appropriate 
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To Select Data Values: Enter: 
column and each subsequent search value in subsequent 
rows of the same column. 

Greater than a lower boundary value > followed by the lower boundary value in the first row 
of the appropriate column. 

Less than an upper boundary value < followed by the upper boundary value in the first row 
of the appropriate column. 

Greater than or equal to a lower boundary value >= followed by the lower boundary value in the first row 
of the appropriate column. 

Less than or equal to an upper boundary value <= followed by the upper boundary value in the first row 
of the appropriate column. 

Where the value in the field is null Type the words IS NULL in the appropriate column. 
(See the examples following this table.) 

Where the value begins with a known string Type the word LIKE then the known value then the 
symbol % in the appropriate column. (See the examples 
following this table.) 

Where the value ends with a known string Type the word LIKE then the symbol % then the known 
value in the appropriate column. 

Where the value is between a known string Type the word LIKE then the % then the known value 
then % in the appropriate column. 

Where there is more than one value in a column  Place a comma between the values. (See the examples 
following this table.) 

Between and including two boundary values There are two methods to find these values: 
 
• >= followed by the lower boundary value the word 

AND <= followed by the upper boundary value. 
• BETWEEN the lower boundary value AND the upper 

boundary value. 
(See the examples following this table.) 

Between and excluding two boundary values > followed by the lower boundary value the word AND 
< followed by the upper boundary value. (See the 
examples following this table.) 

 
Note:  When using the ad hoc query tool, it is important to know the format of the data. For 
example, in the XRAYs/Audits Adhoc Query Form the Action Date is in YYYYMMDD format; 
in the AIRS Histories ad hoc the Action Date is in DD-MON-YY format. If the wrong format is 
used, the data will be inaccurate or you will get a No Data Returned response. See Appendix B 
for the date formats. 
 
The following paragraphs and illustrations in this section show sample queries and descriptions: 
 
• Requesting all records for PUC 001962 and the BUNO is null (all part 1 records for PUC 

001962): 
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• Requesting all Posted XRAYs and audits for PUC 001962 in April 2004: 
 

 
 
• Requesting all XRAY records for BUNOs 162000, 162001, and 162002: 
 

 
 
• Requesting XRAY and audit records for BUNO 165222 with action dates between (and 

including) 19990101 and 20040501: 
 

 
 
• Requesting XRAY and audit records for BUNO 165222 with action dates between (and 

including) 19990101 and 20040501: 
 

 
 
• Requesting all audits with a stat flag of P and PUC between, but not including, 000001 and 

000100: 
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5.8.1.2.6 Computing Columns 
Use the Adhoc Function button to add computed columns to the Adhoc Query Form. These 
columns are not in the database, but are computed from data that is stored there. The functions 
currently available include SUM, AVG, MAX, MIN, and COUNT. For example, a column that 
displays a SUM of the data in a column from the database can be added. The Sum and Avg 
functions are only available for columns that are numbers. When using the Adhoc Functions 
Window, at least one Selected Column must have no function or only the Count function 
selected. If every Selected Column has a function selected (except count), you will receive an 
error and will be returned to the Adhoc Functions Window. 
 

 
 
1. Select columns for the query. 
2. Select the Function button from the Adhoc Query Form prior to entering selection criteria. 
3. On the AdHoc Functions window highlight the file name under the Selected Column and 

click the appropriate radio button. The software creates a computed column and displays the 
name in the Computed Column(s) window of the form. 

4. Select OK to complete the process, or click CANCEL to escape from the process without 
creating any computed columns. 

 
The following illustration shows the Adhoc Query Form - RT79 Form before the Function button 
is selected. See steps 1 & 2 above. 
 

 
 

Clicking the Adhoc Function button opens the Adhoc Functions Window. Notice that the 
Selected Columns are the same as the columns in the Adhoc Query Form. 
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1. Highlight ship_ops_flt_hrs and check the SUM box. 
 

 
 

 
 

2. When sum(ship_ops_flt_hrs) displays in the Computed Column, click OK. The RT79 Ad 
Hoc Window returns with the function in the Criteria Syntax box.  

 

 
 
3. Type P in the Stat Flag field and 010366 in the PUC field, then click Query. The RT79 

Adhoc Query Form returns the requested data. 
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The following illustration shows the sum of the ship_op_flt_hrs, by BUNO and trans_date for 
PUC 010366 and stat_flag of P. 
 

 
 
Note:  The Ship_op_flt_hrs column still exists. Do not place data in fields against where 
functions are running. The query will not pick up any information in those boxes and the data 
returned will be inaccurate. 
 
5.8.1.2.7 Sorting the Query Results Data 
The ad hoc query tool allows data to be sorted in either ascending or descending order for each 
column. 
 
1. To order only one column, double-click on the column name. The column sorts in 

descending order. Double-click the column name again and it sorts in ascending order. 
2. If the report needs more columns to be sorted, you can sort results data on up to five 

columns. 
 
The sort is performed in the order of columns selected. For example, if multiple BUNOs are 
selected in the results set, first select the BUNO column to sort each BUNO’s data by Action 
Date, and then select the Action Date column. The sort is by Action Date within BUNO. 
 
Use the following steps to sort the data resulting from the ad hoc query: 
 
1. Click Sort on the bottom of the form. 
2. The Sort Order Selection Dialog Box opens with only one sort column selected. If 

requested, sort on one column, click the drop-down next to the column field. The software 
displays a pick list of columns available in the selected data set. 

3. Select the desired column to sort from the pick list. 
4. Select sort order (i.e., ASC or DESC). 
5. If sorting more than one column (maximum of five), click Add New. Another row of fields 

appears for an additional column. 
6. To delete a column from the sort selection, highlight the column to be deleted, then click 

Delete. 
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The following illustration shows an example of the Sort Order Selection Window. 
 

 
 
5.8.1.2.8 Formatting Query Results Data 
Use the following steps to organize data returned from a query into a report format: 
 
1. Run desired query. 
2. When data is returned, click Summary. Query results appear in report format. 
 
5.8.1.2.9 Saving the Query Result Data 
The Summary button opens a Summary Window that formats the returned data into a readable, 
printable format. The Summary Window is used to save the data pulled from ad hoc queries. To 
save query results: 
 
1. Click Summary to invoke the Summary Window. 
2. On the IE toolbar, select File > Save As. 
3. Select the file name, location, and type of file (e.g., .xls, .cvs), then click Save. 
The following illustration shows a sample of the Ad Hoc xray Data Results Report. 
 

 
 

42 
Document Version:  4.8 August 28, 2009 

For Official Use Only 



Seaport Contract Number N00178-05-D-4570, Task Order M803 
Users Manual for AIRRS 

Document No. 2006-SPALDING-0776 
 
 

 

5.8.1.2.10 Saving Named Ad Hoc Queries 
1. Click Save Query from the Adhoc Query Form. 
2. Click the appropriate radio button to select the data type category for storing the query (e.g., 

All Queries, AIRS Histories, Flight Records). 
3. Enter query name in the File field. 
4. Click Save to save the query. The query automatically saves under the user’s userid. 
5. To save an existing query for another user, select the userid and the query, and then click 

Save to save that query under the user’s userid. 
 

 
 
5.8.1.2.11 Retrieving, Deleting, and Executing Saved Ad Hoc Queries 
To retrieve a saved ad hoc query: 
 
1. Select Reports > Ad Hoc > Retrieve Saved menu option. Saved Queries by User ID Window 

opens. 
2. Select a userid from the Users column, and click the radio button for the type of ad hoc 

query.  
3. Select the Query name in the Queries block and click Open Query. The window refreshes 

for both steps 2 and 3.) The Adhoc Query Form opens with the query. 
4. Click Query to run the query. 
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To delete a saved ad hoc query: 
 
1. Select Reports > Ad Hoc > Retrieve Saved menu option. Saved Queries by User ID Window 

opens. 
2. Select a userid and click the radio button for the type of ad hoc query.  
3. Select the Query name in the Queries block and click Open Query. The window refreshes 

for both steps 2 and 3.) The Adhoc Query Form opens with the query. 
4. Click Delete Query to delete the query. 
 

 
 
To cancel a query, click Cancel. 
 
5.8.1.2.12 XRAY Detail Drilldown (OPNAV, TYCOM and Wing users only) 
Use the XRAYS/Audits Adhoc Query Form to drill down to the XRAY detail page of a specific 
BUNO based on the SEQNO. 
 
To drill down to the detail page of an XRAY: 
 
1. Run the desired query in the Adhoc Query form. 
2. When data is returned, the Detail button appears at the bottom of the form. 
3. Click Detail. The Show Detail Window opens, prompting for a SEQNO. The following 

illustration shows an example of the XRAY Show Detail Window. 
 

 
 
4. Enter the SEQNO. If two versions of the same XRAY exist, a drop-down list opens so you 

can select the version. Normally the version 2 (the updated version) should be selected, 
unless you are looking up the original XRAY (version 1). 

5. Click Show Detail. The XRAY Show Detail page for the specified SEQNO opens. 
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5.8.2 Reports Inventory Submenu 
The reports are accessed via the Reports Inventory Submenu. The Reports Inventory Submenu 
contains a list of the Inventory reports currently available in AIRRS. Average Hours in Life and 
Retirement Distribution (Op FY) are inactive because they are no longer used. 
 

 
 
5.8.2.1 Generalized Query Tool for Inventory Reports 
AIRRS uses the Generalized Query Tool for all the reports in the Inventory Submenu. The 
Generalized Query Tool opens a dialog box so you can define a report by entering selection 
criteria for creating the report. The Change in Inventory by Quarter, Inventory by Age, and 
Inventory by TMS reports have associated graphs; therefore, the Generalized Query Tool 
includes a Graph button for those reports. The Data button allows you to receive the raw data in 
an Excel format. The Data button should be used when you wish to download the data for more 
manipulation. Use the Report button to see the data in a visually pleasing format. The Reset 
button clears all fields in the Generalized Query Tool. The Cancel button returns you to the 
Welcome Window. 
 

 
 

All fields in the Generalized Query Tool have data selection fields of available data elements. 
For example, clicking the down arrow next to the Type Model field opens a menu of valid Type 
Model designations. 
 
Selecting a particular designation controls the contents of the data elements for the 
Type/Model/Series field. The box is sensitive to the selected report type. Fields that do not 
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require or are not supported by a particular criterion for a specified report type show the down 
arrow and/or field title grayed out. 
 
5.8.2.2 Generalized Query Tool Fields 
The Generalized Query Tool fields (Table 5) may be used in combination to tailor the report 
contents to as broad (all aircraft) or as narrow (a particular TMS in a particular inventory status 
for a particular unit) as desired. 

Table 5.  Generalized Query Tool Fields 

Field Description 
ACC Use to select based on full or partial Command Code according to the codes set forth in 

CNAFINST 4790.2 series. 
• LANT (1x) 

– LANT NAVY (10) 
– LANT MARINE (11) 

• PAC (2x) 
– PAC NAVY (20) 
– PAC MARINE (21) 

• CNARF (3x) 
– CNARF NAVY (30) 
– CNARF MARINE (31) 

• CNATRA (40) 
• NASC (50, 60, 70 or 90) 

– NASC T&E (50) 
– NASC STF (60) 
– NASC FS (70) 

• MARINE (NON-FLEET) (80) 
• MISCELLANEOUS (90) 
• MARINE (ALL) (11 or 21) 
• NAVY (ALL) (10 or 20) 
• NAVY LANT / PAC 
• MARINE LANT /  PAC 
• NAVY LANT / PAC / CNATRA 
• NAVY LANT / CNATRA 

Wing Use to select a Wing based on the ACC that was selected in the ACC field. The Wing field 
contains a list of the Wings, by name. 

Unit Nomen Use to select a Unit based on the Wing that was selected in the Wing field. The Unit Nomen 
field contains a list of Units, by name. 

Type Model Use to select the type and model of the aircraft. The Type Model field contains a list of the 
available Type Model (TM) combinations. 

Type/Model/Seri
es 

Use to select an array of TMSs that are based on the TM that was selected in the TM field. If no 
TM has been selected, an error message appears. 

Inventory 
Category 

Use to select the aircraft status according to the following hierarchy. 
1. Total Overall Inventory 

a. Total Active Inventory 
1) Operating Aircraft Inventory 

a) Dis / Assy for Dpmt 
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Field Description 
b) Transt to / fr Dpmt 

2) Pipeline Acft Inventory 
a) Awaiting/Enroute Operating 
b) In/Awaiting/Enroute Rwk - Standard 
c) In/Awaiting/Enroute Rwk - Special 
d) A/C in First Delivery 

3) Reconstitution Reserve 
b. Total Inactive Inventory 

Class Use to select an aircraft class according to the aircraft’s primary mission: 
• Anti Sub 
• Attack 
• Drone 
• Fighter 
• In-Flight Refuel 
• Observation 
• Other 
• Patrol 
• Rotary Wing 
• Tilt Rotor 
• Training 
• Transport 
• Utility 
• Warning 

Sub Class Use to select the Sub Class based on the class of the aircraft. If no Class is selected in the Class 
field, or if no Sub Classes exist for the selected class, an error message appears. 

Reporting Date Active (not grayed out) for reports that are based on the AIRS Quarterly History data. Selecting 
a date in the Reporting Date field is mandatory. 

Reporting Period The Reporting Period ranges are dynamically set when Reporting Date is selected: 
• 01Apr 2009 thru Present 
• 01 Jul 1994 thru 31 Mar 2009 
• 01 Jan 1992 thru 30 Jun 1994 
• 01 Jul 1989 thru 31 Dec 1991 
These date ranges determine the headings and layouts for reports based on past status category 
definition and nomenclature changes. 

Data Selection Area containing two button-selectable options: 
• Historical Data 
• Current Data 
Only one data selection may be selected at a time. Selecting Historical Data causes the specified 
report to be run against the AIRS History record, the formal quarterly history record from which 
past reports may be reproduced. Selecting Current Data causes the selected report to be run 
against the current data stored in the AIRRS Production Table. 

 
5.8.2.3 Inventory Reports Active and Inactive Status Categories 
The following excerpt from the OPNAVINST 5442.2(series), Table 9, summarizes the status 
categories: 
 
1. Active Aircraft - Operating Aircraft Inventory 

a. Operating = A_0 
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1) Dis / Assy for Dpmt = KGK 
2) Transt to / fr Dpmt = KLK 

b. Pipeline Aircraft Inventory 
1) Awaiting Enroute Operating = BY_, C10, CA0 
2) Enroute/Awaiting/In Standard Rework = F_, E_, D_ 
3) Enroute/Awaiting/In Special Rework = I_, H_, G_ 
4) Aircraft in First Delivery = BX0, BA0, VF0 
5) Reconstitution Reserve = RR0 

2. Inactive Aircraft - Total Inactive Inventory = J_, M_, N_, P_, Q00, S_, T_, U_, W_, Y_ 
 
5.8.2.4 Change in Inventory by Quarter Report 
The Change in Inventory by Quarter Report first requires input of the comparison report dates. 
Be sure the End Reporting Date is greater than the Begin Reporting Date. When using the 
Change Inventory by Quarter Report Window, you cannot select a reporting date from the 
Generalized Query Tool Window. 
 
The Change in Inventory by Quarter Report shows the changes in an inventory over the different 
quarters selected. By double-clicking the left mouse key anywhere on the chart you can view the 
data that comprises the chart. 
 
The following illustration shows the Please Select a Reporting Range Dialog Box. The next 
illustration is an example of a Change Inventory by Quarter graph. 
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5.8.2.5 “Summary” Reports 
The following group of “summary” reports available from the Reports Inventory Submenu use 
the same format: 
 
• Class and Command Summary 
• Class, Command and TMS Summary 
• Class, Command, Unit, and TMS Summary 
• TMS Summary 
 
Select the report depending on the desired detail of results. The report shows the aircraft 
breakdown of OPNAVINST 5442.2 (series), Table 9, per the selection in Generalized Query 
Tool. (The numbers have been set to zero for security purposes.) 
 

 
 
5.8.2.6 Inventory by Age Report 
Inventory by Age Report shows the age of the inventory and the number of aircraft that are at 
each age. The age of an aircraft is determined by the aircraft age in months divided by 12; the 
remainder is dropped. For example, an aircraft is considered 2 years old if it is 24 to 35 months 
old. When the cursor is placed over an individual bar, a small pop-up window shows the age and 
number of aircraft for that bar. The Inventory by Age Window has more specific data by TMS 
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(the graph shows the grand total). The age is calculated the same as above. The Type Model 
Series Avg Age column is the summation of all the aircraft age in months in the TMS divided by 
12 divided by the number of aircraft in the TMS. The Class Code Avg Age column is the 
summation of all the aircraft age in months in the Class Code divided by 12 divided by the 
number of aircraft in the Class Code. To see the Graph, click Graph on the Generalized Query 
Tool. To see the report click Report. Data in the report has been set to zeroes for security 
purposes. 
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5.8.2.7 Inventory by TMS Report 
Inventory by TMS shows the number of aircraft that are in the inventory per the selection created 
in the Generalized Query Tool. To view the graph, click Graph. When the cursor is moved over 
an individual bar, a small pop-up window shows the TMS and number of aircraft for that bar. To 
see the data behind the window, click the Report button on the Generalized Query Tool. 
 

 
 
5.8.2.8 Pipeline by Model (L-17) Report 
Pipeline by Model (L-17) report is a summary report sorted and summarized by Class and TMS. 
The report is limited to Active aircraft only. Pipeline Percent equals Total Pipeline divided by 
Total Active. (The numbers in the following report have been zeroed out for security purposes.) 
 

 
 
5.8.2.9 Pipeline by Model (L-17A) Report 
The Pipeline by Model (L-17A) report is identical to L-17, except for the capability to show a 
range of fiscal year (FY) quarters instead of only one quarter. (The numbers in the following 
report have been zeroed out for security purposes.) 
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5.8.2.10 Retirement Distribution Graph (Op FY) Report 
The Retirement Distribution Graph report is inactive because it is no longer used. 
 
5.8.2.11 Total Inventory Summary Report  
Total Inventory Summary Summarizes aircraft status codes described in Section 5.8.2.3. The 
report will have numbers to the right of the titles. The numbers have been set to zeroes in the 
example shown for security reasons. 
 

 
 
5.8.2.12 Saving Report Output to File 
Use the following steps to save the report to a local disk file: 
 
1. In the Generalized Query Tool, click Data to retrieve the data in an Excel format. 
2. Select the Save As option from the File Menu. 
3. Enter the directory path and file name for data retrieved in the File Name entry field. 
4. Select the desired format of the output file selecting the appropriate file type (usually 

Microsoft Excel or Tab Delimited Text) from the list of values. 
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5.8.2.13 Printing Reports to Local Printer 
Before printing a page, select File > Print Preview in IE to ensure that the page will print as 
expected. If the report is cut off at the right margin, select Page Setup and select Landscape 
(instead of Portrait) orientation. Most of the reports are written to use the Landscape orientation. 
To print the report contents to a local printer: 
 
1. Select File from the IE Main Menu. 
2. Select File>Print Preview to ensure the page layout is set to accommodate the report format. 
3. Select Print and click OK. 
 
5.8.3 RT79 and QHIL Non-reporting Units 
The RT79 and QHIL Non-reporting Units report selects by PUC all the BUNOs that do not have 
an RT79 or Quarterly Hrs in Life records submitted during the months specified. If a BUNO is 
owned by multiple PUCs in a month, all the PUCs are expected to turn in an RT79. To save data 
to a file, follow the instructions in Section 5.8.2.12. 
 
Use the following steps to generate the RT79 or Audit Non-reporting Units Report: 
 
1. Set ACC. 
2. Select by Type Wing. 
3. Select specific a PUC or All Codes. Note:  To include all PUCS in the report, do not 

highlight any value in the PUC LOV. 
4. Specify a Reporting Period. 
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The results are ordered by BUNO, Wing Nomen, PUC, Unit Name Short, and Trans Date. The 
following illustration shows an example of the RT79 Non-Reporting Units report layout (no 
data). 
 

 
 
5.8.4 5 Year Attrition Rates 
Select the Five Year Attrition Rate item from the Reports Menu to generate the 5 Year Attrition 
Report. The 5 Year Attrition Report shows the aircraft inventory over the last 5 years. It uses the 
inventory data to calculate percentages of aircraft loss from year to year. To view the report, 
select Report on the 5 Year Attrition Rate Submenu. To retrieve the raw data, select Data. 
 

 
 
5.9 Maintenance Menu 
The following illustrations show the Maintenance Menu options available to TYCOM and 
OPNAV users, respectively. 
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AIRRS allows authorized users to maintain key tables of data about the Naval aircraft inventory 
and organizational structure. The following is a description of changes by authorized user type. 
Authorization to perform the listed functions is based on the user role assigned to the individual 
user. 
 
Authorized users with an OPNAV role may: 
 
• Add new aircraft to the inventory 
• Enter Strike Authorization Lists 
• Update Capability Goals 
• Update Period Standards 
• Create new Organizations 
• Modify Organizations 
• Create new TECs 
• Enters TEC Life Limits 
 
Authorized Aircraft Inventory Managers with a TYCOM role at the ACCs may: 
 
• Create new Wings 
• Update Squadron/Wing/TYCOM associations 
• Create and assign new special characteristics 
• Add new Standard Location Names and Common Location Variations 
 
5.9.1 Maintenance Organizations Submenu 
The Maintenance Organizations Submenu contains three options:  Organizations, Wings, and 
Organizations View. 
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5.9.1.1 Create a New Organization (Squadrons or Wings) 
 

 
 
To create a new organization (Squadrons or Wings): 
 
1. Select New and enter the new information in the form fields. The fields with yellow 

backgrounds are mandatory for creating a new organization. 
2. Click Save to update the data in the database or select Cancel to clear all previously entered 

data. 
 
Note:  If an organization has a name variation, do not use this window to enter a new 
organization. Use the Organization Variation Window (Section 5.9.3.10). 
 
5.9.1.1.1 Wing Assignments 
To make a Wing assignment: 
 
1. Select Maintenance Menu > Organizations > Organizations. 
2. Wings can be associated to an Organization Code by selecting Wing Assignments. A Wing 

Assignment Detail Window opens. 
3. Select the Primary, Carrier Air Wing (CVW), or Secondary fields as appropriate and select a 

Wing name from the list of values. 
4. The Begin Date defaults to the current date. 
5. Repeat steps 3 and 4 until all Wing names and begin dates have been entered. Click Save. 
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5.9.1.1.2 View PUC Assignments 
To view a PUC already associated with an Organization Code, select PUC Assignments. A PUC 
Assignment Detail Window shows the PUC(s) assigned to an Organization Code. If no PUC is 
assigned, a message opens to inform you that there are “No PUCs assigned to this ORG”. 
 
5.9.1.1.3 Create PUC Assignments 
To create a PUC assignment: 
 
1. Place the cursor in the Org to which the PUC will be related, and then click Create New 

PUC. 
2. Enter the PUC, Activation Date, and Location. The Reports RT79 Data field defaults to Y 

(Yes). 
3. Click Save. 
 
5.9.1.1.4 Modify Organizations 
The only information that can be modified is the Unit Short Name and Unit Long Name. Any 
other modification requires that you deactivate the Organization Code and establish a new 
Organization Code. 
 
1. Select the Maintenance Main Menu option to open the Maintenance Menu. 
2. Select the Organizations option from the Maintenance Menu to open the AIRRS 

Organization Submenu. 
3. Select Mod Unit Name. This option highlights the Unit Short Name Field in purple and 

allows you to change the Unit Name. You can now also change the Unit Long Name now. 
4. After the changes are complete, click Save. 
 
5.9.1.2 Wings 
The following illustration shows the Airrs Wings Maintenance Window. 
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5.9.1.2.1 Create New Wings 
To create a new Wing: 
 
1. Click New. (Mandatory field entries have a yellow background.) 
2. Select the appropriate Command from the list of values. 
3. In the Wing field, enter a Wing name that is 25 characters or less. 
4. Select the Control Code from the list of values: 

a. Primary = Primary Wing/Commander Fleet Air (COMFAIR) 
b. CVW = if Wing is a Carrier Air Group 
c. Secondary = Secondary Wing/COMFAIR 

5. Status Date is the effective date of the Wing. 
6. Status of the Wing defaults to Active. 
7. Click Save. 
 
5.9.1.3 Organizations View 
The Organization List View is a read-only window that contains the Org Code, Unit Name Short, 
Org Type, Unit Identification Code (UIC), the date it was established, the date it was 
disestablished, and the party who modified the information. If the disestablish date is empty, the 
Org Code is still active. 
 

 
 
5.9.2 Capability Goals 
The Capability Goals data is updated with each revision of CNAFINST 4790.2 (series). 
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1. Use the upper window to select the TMS. The bottom window shows the associated 

capability goals. 
2. Select New to make a change to the capability goals. The TMS field becomes a drop-down 

list. 
3. Enter the first letter of the TMS. All TMSs that begin with the entered letter appear in the 

drop-down list. 
4. In the Capability Goal Date field, enter the date of the OPNAVINST 5442.4 (series) or the 

date the Capability Goal became effective. Enter the date in an YYMM format. 
5. Enter the MC and FMC percentages as whole numbers (omit the % sign). 
6. Enter Engineering Service Life Hours, if known. 
7. After entering data, click Save. 
8. Cancel is used to stop a new entry prior to a Save action. 
 
5.9.3 Maintenance Class Subclass Submenu 
The following illustration shows the Maintenance Class Subclass Submenu. 
 

 
 
5.9.3.1 Class 
The AIRRS Classes Window contains all the class codes and their descriptions. To enter a new 
Class of aircraft into AIRRS, click New, type the class code, and description in the fields located 
at the bottom of the window, and then click Save. 
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The following illustration shows an example of the AIRRS Classes Window. 
 

 
 
5.9.3.2 Subclass 
The Class/Subclass Relationships Window contains all the subclasses in each class. To view the 
subclasses detail for a particular class, place the cursor in the appropriate class code. To create a 
new Subclass: 
 
1. Place the cursor in the Class Code with which the Subclass is to be associated and click 

New.  
2. Enter the plane code, subclass description, and subclass code, then click Save.  
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5.9.3.3 Commands 
Clicking the Command option on the Maintenance Menu opens the AIRRS Commands Data 
Maintenance Window so authorized users can enter new Command codes or deactivate existing 
Command codes. To create a new Command: 
 
1. Click New and enter the following information: 

a. Command’s full name into the Command box. 
b. Two-digit code (Navy commands should end with a 0 and Marine commands a 1) into 

the Code box. 
c. Command short name (must be 15 or less characters). 
d. Unit ID code. 
e. Start Date. 

2. Click Save. 
3. To deactivate an existing command, enter the date the command was deactivated (DD-

MMM-YYYY format). Click Update. 
 
5.9.3.4 Enter New Aircraft 
Each time an aircraft is acquisitioned by the Navy, OPNAV N88 assigns a BUNO. Normally, a 
range of BUNOs is assigned to a particular order of a number of aircraft of the same TMS. 
AIRRS XRAY, Audit, and RT79 validation software compares the BUNO of the incoming 
transaction to the table of BUNOs maintained in the database. 
 
If the transaction BUNO matches an entry in the table, the BUNO is considered valid. If the 
transaction BUNO is not found in the table, it is considered invalid. 
 
BUNOs are entered in the database via the Enter New Aircraft Window: 
 
1. Select Maintenance > Enter New Aircraft menu option to open the Enter New Aircraft 

Window. 
 

 
 
2. Enter the Starting BUNO in the Starting BUNO field. 
3. Select the TMS from the list of values in the TEC/TMS field. 
4. Type a value or use the list of values in the Number of BUNOs field to select the number of 

BUNOs to generate. 
5. Click Save. The software generates the requested number of new BUNO records beginning 

with the specified starting number. 
 

61 
Document Version:  4.8 August 28, 2009 

For Official Use Only 



Seaport Contract Number N00178-05-D-4570, Task Order M803 
Users Manual for AIRRS 

Document No. 2006-SPALDING-0776 
 
 

 

5.9.3.5 TEC TM Data 
5.9.3.5.1 Enter a New Type Model (Three-Position TEC) 
1. Select the TEC TM Data Submenu from the Maintenance Menu to open the TEC TM Data 

Window. 
2. Select New and make entries in the following mandatory fields:  TEC TM, Description, TM, 

and Category. 
3. Enter data in other fields as appropriate. 
4. Click Save. The window refreshes and shows in the upper section the record you added. 

Records appear in alphabetical order. 
 

 
 
5.9.3.6 Maintenance TEC TMS Data Submenu 
The following illustration shows the Maintenance TEC TMS Data Submenu. 
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5.9.3.6.1 TEC TMS Data 
Before a four-position TEC can be created, a three-position TEC must exist. 
 
5.9.3.6.1.1 Enter New Aircraft, Missile and Support Equipment TECs 
The following illustration shows the TEC TMS Data Window. 
 

 
 

1. In the upper window, select the TEC TM to add a new four-position TEC. 
2. Click New. 
3. Enter the four-position TEC corresponding to the selected TEC TM. 
4. Enter the Description. For TECs ‘A,’ ‘K,’ and ‘N’ enter the TM Series (e.g., C-130J, SH-

60B). 
5. Enter the Entry Date in MM/DD/YY format. The Entry Date reflects the effective date of 

the TEC, not the date the data is being entered. 
6. Select the appropriate Category from the drop-down list. 
7. For TECs ‘A,’ ‘K,’ and ‘N’ select the appropriate Class from the drop-down list. 
8. Enter any other data as appropriate. The mandatory fields have a yellow background. 
9. Click Save. 
 
Note:  When entering aircraft data, it is essential to select a Class (and a subclass, if appropriate). 
If the class is not entered, the reports will not show the existence of the aircraft. 
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5.9.3.6.2 Engines TEC 
5.9.3.6.2.1 Enter New Engine TECs 
The following illustration shows the TEC Data Window. 
 

 
 

1. In the top window, select the TEC TM to add a new four-position TEC. 
2. Select New. The mandatory fields are highlighted in yellow. 
3. In the TEC TMS field, enter the new four-position TEC. 
4. To associate aircraft TMS that relate to the engine, click on the appropriate TEC TM in the 

Available Aircrafts box. Then click the << button to move the TEC TMS to the Current 
Relationship(s) to Aircrafts box. Repeat this step for each TEC TMS that applies. 

5. Click Save. 
6. To Dissociate aircraft TMS related to an engine, click the TM box under ‘Current 

Relationship(s) to Aircrafts’ of the TMS to dissociate and select the >> button. 
7. Click Save. 
 
5.9.3.6.3 Training TEC 
5.9.3.6.3.1 Enter New Training Devices TECs 
1. In the top window of the TEC Data form (see Section 5.9.3.6.2.1), select the TEC TM to add 

a new four-position TEC. 
2. Click New. The mandatory fields are highlighted in yellow. 
3. In the TEC TMS field, enter the new four-position TEC. 
4. To associate aircraft TMS that relate to the Training Device, click the appropriate TEC TM 

in the Available Aircrafts box.  
5. Click the << button to move the TEC TMS to the Current Relationship(s) to Aircrafts box. 

Repeat steps 5 and 6 for each TEC TMS that applies. 
6. Click Save. 
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7. To dissociate aircraft TMS related to a Training Device, click the TM box under ‘Current 
Relationship(s) to Aircrafts’ of the TMS to dissociate and click the >> button. 

8. Click Save. 
 
5.9.3.7 TEC TMS/Mfg Parts 
5.9.3.7.1 Enter New Support Equipment TECs 
The TEC TMS Data Entry Window is a multi-purpose entry window that allows input for 
establishing new support equipment TECs. The window also allows input for manufacturers, 
Commercial and Government Entities (CAGEs), part numbers, and publications associated with 
support equipment. 
 

 
 
Use the following steps to enter a new Support Equipment (SE) TEC: 
 
1. Select from the Maintenance Menu > TEC TMS/Mfgr Parts Submenu. The left-hand portion 

of the window is used to enter SE TECs. 
2. Select the appropriate Type Equipment from the upper left-hand corner of the window. 
3. Click New TEC TMS. In the TEC TMS window, enter the new TEC in the TEC field. 
4. Enter the date the TEC became effective in the Entry Date field using MM/DD/YY format. 
5. Click Save TEC TMS. 
6. Use Cancel TEC TMS to clear previously entered data prior to using Save TEC TMS. 
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5.9.3.7.2 Associate Manufacturers/Part Numbers to SE TEC 
To associate manufacturers and part numbers with an SE TEC: 
 
1. Select from the Maintenance Menu > TEC TMS/Mfgr Parts Submenu. 
2. On the right hand portion of the window, select the desired manufacturer from the 

Manufacturer’s box. Part numbers associated with the selected manufacturer appear in the 
Parts box. 

3. Click to highlight the desired part number, and then select << to move the data to the 
TEC/Parts Association box.  

4. Repeat steps 2 and 3 until all desired part numbers appear in the TEC/Parts Association box. 
5. Click Save. 
6. To remove a part number’s association to a TEC, select the part number in the TEC/Parts 

Association box and select >>. 
7. Click Save. 
8. Click Cancel to remove a previous entry in the TEC/Parts Association box prior to clicking 

Save. 
9. To Dissociate a Part Number to TEC relationship, in the lower left corner of the window, 

select the Part  Number Dissociation button. 
10. A box will appear to confirm the dissociation. Select Cancel to stop the action or OK to 

Save the dissociation action. 
 
5.9.3.7.3 Enter a New Manufacturer 
To enter a new manufacturer: 
 
1. Select from the Maintenance Menu > TEC TMS/Mfgr Parts Submenu. 
2. In the Manufacturers box, select New Mfg. A blank row appears in the bottom of the box. 
3. Enter the Manufacturer Name and CAGE Code. 
4. Click Save Mfg. 
5. Click Cancel Mfg to clear any previously entered data prior to clicking Save Mfg. 
 
5.9.3.7.4 Enter a New Part Number 
To enter a new part number: 
 
1. Select from the Maintenance Menu > TEC TMS/Mfgr Parts Submenu. The new part number 

must be associated with a manufacturer.  
2. Select the manufacturer from the Manufacturer box. 
3. In the Part Detail box, select New Part. 
4. In the Part Detail box, enter the Model Number, Part Number, and any technical publication 

information. 
5. Click Save Part. The new part is now associated with the selected manufacturer. 
6. Click Cancel Part to clear any previously entered data prior to clicking Save Part. 
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5.9.3.8 TEC Life Limits 
The TEC Life Limits Window inserts the latest life limits for TMS. The Effective date indicates 
when the life code became active for the TMS. If there is more than one life code for a TMS, the 
latest effective date indicates the current life code. To see the details of the TMS’s life code, 
place the cursor in the Type Model Series field for the selected life code and effective date. 
 
The following illustration shows the TEC Life Limits Window. The data shown is not accurate 
for security purposes. 
 

 
 

Life Codes: 
 
02 - ESL/HR LFE 
10 - OSL/OSM 
12 - OS-PERIOD 
14 - OS-NON-OP 
24 - CATS 
26 - ARRESTS 
28 - LANDINGS 
42 - OSP-IMC-CV 
43 - OSP-IMC-L 
94 - CATS/BUNO 
96 - ARST/BUNO 
98 - LAND/BUNO 
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5.9.3.9 Locations and Location Variations 
The AIRRS software maintains a list of official Location Names against which location data 
reported in XRAY transactions are validated. Additionally, the software maintains a list of 
common Location Name Variations to ease the burden of Inventory Managers from having to 
correct improperly entered Location Names. 
 
The XRAY validation software first looks in the Standard Location Names table to find a match 
of the reported Location Name. If it finds a match, the location name is deemed valid. If it cannot 
find a match, it searches the Location Variations table. If a match is found there, the software 
substitutes the Standard Location Name associated with the variation in the original XRAY 
transaction and deems the location field to be valid. If no match is found, the location is deemed 
invalid. 
 
The AIRRS software also provides windows for maintaining both Standard Location Names and 
Common Location Variations. The rules for using these functions are: 
 
1. To add a Standard Location Name (for example, the name of a newly-established air station 

or ship), use the Add a New Location steps in Section 5.9.3.9.1. Do not add a new Standard 
Location Name entry for a location that already exists in the database. 

2. To add a Common Variation of a Standard Location Name (that is, a common misspelling or 
other variant of a Standard Location Name), use the Add a Location Variation steps. 

 
5.9.3.9.1 Add a New Location 
Use the following steps to a new Location: 
 
1. Select the Maintenance - Locations menu entry. The software opens the AIRRS Location 

Maintenance Form. The window consists of two windows. The upper window shows the list 
of Standard Location Names currently in the system. 

2. Click New at the bottom of the form. The software displays a blank form in the lower 
window. 

3. Enter the location name in the Location field. 
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4. If known, enter the International Civil Aviation Organization (ICAO) code in the ICAO 
field. 

5. To submit the change, click Save. 
6. If there are additional locations to enter, return to Step 1. 
 
5.9.3.9.2 Add a Location Variation 
Use the following procedure to add a new Common Location Variation for an existing Standard 
Location Name: 
 
1. Select the Maintenance - Location Variations menu option to open the AIRRS Location 

Variations Window. 
2. The Location Variations Window has an upper and lower section. The upper section opens a 

list of the Standard Location Names currently in the database. The lower section opens a list 
of all Common Location Variations associated with the Standard Location Name indicated 
in the upper section. 

 

 
 

3. To add a new Variation for an existing Standard Location Name, scroll through the upper 
section list to find the desired Standard Location Name and click that row. 

4. Click New at the bottom of the window. A blank entry appears at the bottom of the list in 
the lower section. 

5. Enter the location name variant desired in the blank entry field. 
6. Click Save at the bottom of the window. 
7. If there are additional variations to enter, return to Step 1. 
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5.9.3.10 Organization Variations 
The Organization Variation Window allows TYCOM and OPNAV users to enter variations of an 
organization: 
 
1. Scroll until the Unit Name Short is in view, then place the cursor in the organization field 

that corresponds with that Unit Name Short.  
2. Click New, place the Name Variation in the empty box, and then click Save. 
 

 
 

5.9.3.11 Maintenance Special Characteristics Submenu 
5.9.3.11.1 Create/Assign New Special Characteristics 
The AIRRS software maintains a list of Special Characteristics that may be assigned to 
individual aircraft (by BUNO). Special characteristics currently listed include the following: 
 
• AV-8B Night Attack 
• AV-8B Radar 
• AV-8B Reman/Radar 
• AV-8B Day Attack 
• NAV-8B/NTAV-8B 
• Grp 0 E-2C 
• Grp 1 E-2C 
• Grp II E-2C 
• HE 2K E-2C 
• MCU E-2C 
• NAV E-2C 
• FA-18 Night Attack 
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The Special Characteristics information is linked to individual aircraft with start and end dates 
delimiting the period during which the special characteristic is associated to the aircraft. Use the 
following steps to create new special characteristics entries: 
 
1. Select the Maintenance Menu, Create New Special Characteristics Submenu. 
2. Click New. The following illustration shows the Airrs Special Characteristics Window. 
 

 
 
3. Enter the next three-digit sequential code in the Code field. 
4. Tab to the Description text box. 
5. Enter the descriptive text. 
6. Click Save. 
 
Use the following steps to create or assign special characteristics entries: 
 
(This section is under development.) 
 
5.9.3.12 Strike Authorizations 
Each time an aircraft is stricken from the Naval inventory for any reason other than Category 1 - 
Strike Due to Damage, the strike action has to be authorized first by a Strike Board. The Strike 
Board issues a list of aircraft to be stricken. When a strike action XRAY is received by AIRRS, 
validation checks the Strike Damage Code to determine if it is other than a Category 1 strike. If it 
is, the BUNO is referenced in a table of authorized strikes based on the Strike Board’s list. 
 
5.9.3.12.1 Enter BUNO into Strike Authorization Table 
To get the BUNO into the table, authorized users select the Maintenance > Strike Authorizations 
Submenu option to open the Strike Authorization Window. The Strike Authorization Window 
contains a list of all past Strike Authorizations, in order by BUNO, in the database. 
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5.9.3.12.2 Enter New Strike Authorizations 
Use the following steps to enter one or more new Strike Authorizations: 
 
1. Click New at the bottom of the window. A blank line appears at the bottom of the existing 

Strike list. 
2. Enter the BUNO in the BUNO field. 
3. Select the Command from the Command drop-down list. 
4. Enter the Strike Authorization reference in the Authorization field. 
5. Enter the Authorization Date in the Auth Date field. 
6. Click Save. 
7. To enter more Strike Authorizations, return to Step 1. 
 
5.9.3.12.3 Revoke Strike Authorizations 
Occasionally, a previously entered Strike Authorization must be revoked because it was entered 
incorrectly or because the Strike Board revoked it. To revoke a previously entered Strike 
Authorization: 
 
1. Click in the BUNO box of the row to be revoked. 
2. Click in the Auth box in the same row. 
3. Click Revoke at the bottom of the list. The Revoke field is populated with the current date, 

which is not an editable field. 
 

 
 
5.9.4 Admin Menu 
Only the AIRRS Admin role may use the Admin Menu. 
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5.9.4.1 Update App Version 
The following illustration shows the AIRRS Admin >Update App Version option. 
 

 
 
Only the AIRRS Admin role can change the application version number. The following 
illustration shows an example of the AIRRS Application Version Window. 
 

 
 
5.9.4.2 Set ACC 
The following illustration shows the AIRRS Admin >Set ACC option. 
  

 
 
Selecting the Set ACC option opens the Set ACC Dialog Box, shown in the following 
illustration. 
 

 
 

5.10 Help Menu 
The following illustration shows the Help Menu. 
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5.10.1 Contents 
The Contents option opens the AIRRS UM in PDF format. 
 
5.10.2 Messages 
Selecting the Messages option opens a window containing system messages. The following 
illustration shows an example of the Messages Window. 
 

 
 

5.10.3 About AIRRS 
Selecting About AIRRS from the Help Menu opens the About AIRRS Window. The following 
illustration shows an example of the About AIRRS Window. 
 

 
 
5.11 Miscellaneous Buttons 
5.11.1 Print 
For instructions on using the Print function, see Section 5.8.2.13. 
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5.11.2  Site Map 
Use the AIRRS site map to navigate through the application without having to use the mouse 
(508 compliance). To use the Site Map without the mouse, press the keyboard Tab key until the 
Site Map option is highlighted. 
 
The following illustration shows an example of the Site Map options. 
 

 
 
5.11.3 Log Out 
To log off the AIRRS application, click Logout located at the top of the window. 
 
6.0 AIRRS Transaction Processing 
The AIRRS software is designed around a display and processing paradigm that remains the 
same regardless of transaction type (i.e., the steps required for reviewing and correcting XRAYs 
or RT79s, are all essentially the same). The key elements of the paradigm are transaction 
windows, status flags, display states, and sequence and version numbers. 
 
6.1.1 Transaction Windows 
The software provides two levels of windows for reviewing and correcting transactions:  
summary windows and detail windows. 
 
6.1.1.1 Summary Windows 
Summary Windows list a limited number of data elements about an individual transaction. These 
elements vary from transaction type to transaction type but generally consist of a BUNO, PUC, 
Correction Indicator, Action or Report Date, SEQNO, and version number fields. Additionally, 
the Summary Window contains a colored flag to the left of each entry to indicate the validation 
status of the record. 

75 
Document Version:  4.8 August 28, 2009 

For Official Use Only 



Seaport Contract Number N00178-05-D-4570, Task Order M803 
Users Manual for AIRRS 

Document No. 2006-SPALDING-0776 
 
 

 

76 
Document Version:  4.8 August 28, 2009 

For Official Use Only 

6.1.1.2 Detail Windows 
Detail windows (Table 6) contain all the data elements visible to the user for a single transaction 
record. The detail windows differ from one transaction type to another because the data elements 
are different. Use the detail window to make corrections to invalid transactions or to change 
valid but otherwise incorrect transactions. 

Table 6.  Detail Window Functions 

Button Role Description 
Calc Table All Use to see what is in the Calc Table for a given BUNO. 
Cancel All Cancels the action and returns to the Welcome Window. 
Delete TYCOM The record is not physically deleted from the database. It is set to a stat flag of 

D for historical purposes so the system will no longer ‘see’ the XRAY. 
History 
(XRAY/Audit) 
XRAY History 
(RT79) 

TYCOM, 
Wing 

Returns all XRAYs and audits for the BUNO. Be sure to click the audit 
indicator and stat flag boxes, which will indicate if the row contains an XRAY 
or an audit (X or A in the audit indicator column) and the status flag of the 
record (see Section 6.1.2 for more details). If the XRAYs are out of order, click 
Sort, then select Audit indicator Desc and Action Date Desc, in that order, to 
separate the XRAYs and Audits and to order them by action date. 

Override TYCOM To override an error, place the cursor in the field and click Override. The 
record revalidates and the screen refreshes without the error. Override should 
only be used when the information is correct but the record is failing validation.

Update TYCOM, Wing If the version number is 1, Update creates and revalidates a version 2 XRAY. 
The version 1 XRAY is saved as originally inserted into the database for 
historical purposes. If the version number is 2, using Update will update and 
revalidate the version 2 XRAY. 

Validate TYCOM, Wing Validate only revalidates the XRAY. If no changes are made in the fields, it is 
better to use Validate to keep the database uncluttered. 

 
6.1.2 Status Flags and Transaction Validity 
Each transaction record in the AIRRS database has a status flag that identifies its status in the 
processing cycle. Visual analogs of these status flags are shown on the Summary Window in 
different colors. The status flags are one-character indicators, the value of which can be 
interpreted as shown in Table 7. 

Table 7.  Status Flag Indicators and Values 

Flag Description 
A The transaction is Awaiting validation (i.e., it has either just been loaded into the system and has not yet 

been through the validation cycle, or the record may have begun the validation process but a software 
failure left it in the A status). An ‘A’ status results in a Yellow flag displaying to the left of the record on 
the Summary Window. 

V The transaction is Valid according to the rules programmed into the validation software. 
 
Note:  A record identified by the software as valid may not necessarily be correct. The complexity of the 
validation rules can result in a successful validation when the content of the record may not be in 
accordance with the intent of the governing OPNAV instruction. A ‘V’ status results in a green flag 
displaying to the left of the record on the Summary Window. 
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Flag Description 
I The transaction is Invalid. It has failed the validation process. An ‘I’ status results in a Red flag displaying 

to the left of the record on the Summary Window. 
W The transaction is Waiting for an earlier transaction (i.e., one with either an earlier Action Date or with the 

same Action Date and a lower Order Number). Because of the sequential nature of transaction processing, 
the validation of a transaction cannot be relied upon unless all earlier transactions are considered valid. A 
‘W’ status results in a Yellow flag that appears to the left of the record on the Summary Window. 

P The transaction has been Posted. Valid transactions are Posted to the production tables in the database, 
from which reports are generated and in which historical information is stored. A ‘P’ status results in a 
Green flag displaying to the left of the record on the Summary Window. 

D The transaction has been Deleted (i.e., logically, but not physically from the database) either by user action 
or by being replaced by a Delete/Correct transaction. ‘D’ status transactions are invisible to the validation 
and the posting processes. Deleted transactions, however, are, maintained in the database and can be 
viewed by authorized users via the ad hoc query capability. 

R The transaction has an error that will require further intervention to fix. R is a manually created flag used 
by the maintenance programmer to allow normalization to continue until the problem has been resolved. 

 
6.1.3 Display States 
Each transaction in the AIRRS database contains a Display State indicator that is used to 
determine whether the record should appear in the Summary Window each time it is opened. 
 
Display States are maintained separately from Status Flags because the user may desire to keep a 
record on the Summary Window for reference purposes, regardless of its Validation Status. 
 
The Display State is a four-character field, the value of which can be interpreted as follows: 
 
• KEEP - Keep the transaction available to the Summary Window query process so that it may 

be included each time the Summary Window opens. 
• DROP - Drop the transaction from the Summary Window process so that it does not appear 

each time the Summary Window opens. 
 
6.1.4 SEQNOs and Version Numbers 
The AIRRS software uses system-generated SEQNOs and Version Numbers as primary keys to 
identify records within a table. SEQNOs and Version Numbers are assigned by the system as the 
records are loaded into their respective tables. Each new record loaded is assigned a new 
SEQNO and a Version Number of 1. Note that SEQNOs and Version Numbers reflect only the 
order in which the records were loaded and have no true relationship to the sequence in which 
the transaction should be processed. (See Section 6.1.5.) 
 
The software only assigns a Version Number of 2 to records that have been edited, corrected, or 
modified by a user via the Detail Window Update process. The SEQNO and Version Number are 
shown on both the Summary Window and Detail Window for the following purposes: 
 
1. The user may reference the numbers in reporting problems to software maintenance 

personnel. 
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2. The user may enter the numbers as references for the Delete/Correct process when the 
process has been unable to automatically identify either of: 
a. The appropriate Original record reference by the Delete transaction. 
b. The appropriate Delete record referenced by the Correct transaction. 

 
6.1.5 Order Number 
When more than one status code change is reported on the same Action Date, AIRRS uses the 
order number to identify the order of the transactions. Transactions are numbered sequentially 
(e.g., 1, 2, 3) to identify the sequence in which they occur. The highest number represents the 
latest status to occur for an Action Date. 
 
7.0 Error Messages and Recovery Actions 
Table 8 identifies the various input XRAY data elements and the corresponding validations 
performed for each. The error message resulting from each validation is also shown. 

Table 8.  Data Elements and Validations 

XRAY Data Element Validation Error Message 
BUNO Cannot be blank. 100099-Cannot be Blank. 
 Must be numeric; 6-position (cannot = 0). 100100-BUNO cannot be greater than 6 

digits. 
100101-BUNO not numeric. 

 Must be in AIRRS database (cmis_platform 
table). 

100102-BUNO not found in database. 

 Duplicate XRAY with same BUNO, Action 
Date and Order Number. 

100103-More than one duplicate prior 
rows with same BUNO, action date and 
order number. 

 Strike authorization not recorded for this 
BUNO. 

100105-No Strike Authorization on file 
for this BUNO. 

 Duplicate XRAY with same BUNO, Action 
Date and Order Number. 

100189-Duplicate BUNO, action date, 
order number record found matching this 
record. 
100190-More than one duplicate BUNO, 
action date, order number record found 
matching this record. 

 Must be in AIRRS database (cmis_platform 
table). 

100402-BUNO not found in database. 

 Must not be stricken. 100501-BUNO cannot be stricken from 
the database. 

TMS Cannot be greater than 15 characters. 100171-TMS cannot be more than 15 
characters long. 

 Check for valid TMS against AIRRS. 100172-TMS not found in master TMS 
list. 

 TMS must be same as prior TMS for this Action 
Code. 

100173-TMS must be the same as prior 
XRAY TMS. 

 TMS must be different from prior for Action 
Code ‘M’. 

100174-TMS cannot be equal to prior 
XRAY TMS for this Action Code. 
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XRAY Data Element Validation Error Message 
 TMS cannot be blank for this Action Code. 100177-TMS cannot be blank for this 

Action Code. 
PUC PUC must be established as of Action Date. 100104-PUC found in database but 

disestablished as of Action Date. 
 PUC cannot be blank. 100106-PUC cannot be blank. 
 PUC must be in AIRRS database. 100107-PUC not found in database. 
 PUC must be same as previous reported PUC 

with Action Code; ‘E’,’H’,’M’,’S’,’X’,’L’. 
100108-PUC must be same as previous 
XRAY PUC for this Action Code. 

 PUC cannot be same as previous reported PUC 
with Action Codes; F’,’G’,’R’. 

100109-PUC must not be the same as 
previous XRAY for this Action Code. 

 PUC must be 6 digits. 100110-PUC must be exactly 6 digits 
long. 

 PUC must be numeric. 100111-PUC must be numeric. 
ORG CODE Organization Code must be 3 characters. 100350-AV-3M Organization code 

cannot be greater than 3 characters. 
 Organization Code must be reported on 

Organization Change Location only. 
100351-AV-3M Organization code must 
be blank. 
100352-AV-3M Organization code 
cannot be blank for this Action Code. 

 Organization Code must be in AIRRS database. 100353-AV-3M Organization code not 
valid. 

 Action Date of XRAY must fall within 
Organization Code establish and disestablish 
dates. 

100354-AV-3M Organization code not 
valid in combination with PUC. 

LOCATION Location name must be in AIRRS database. 100391-Aircraft Location on the XRAY 
not valid. 

 Location name must be different from previous 
reported Location for L Action Code. 

100392-Aircraft Location cannot be the 
same as the prior XRAY aircraft location 
for L Action XRAYs. 

 Location cannot be blank for this Action Code. 100393-Aircraft Location cannot be 
blank. 

 Location name must be in AIRRS database. 100398-Unit Location is not valid 
location. 

STATUS CODE Check for valid prior status code sequence 
against AIRRS status code stored procedure. 

100159-Status Code/Prior Status Code 
combination not valid. 

 Status Code must be in AIRRS database. 100160-Status Code is invalid. 
 Status Code must be 3 characters. 100161-Status Code must not be longer 

than 3 characters. 
 Status Code cannot be blank for this Action 

Code. 
100162-Status Code cannot be blank. 

 Status Code position 1 cannot equal ‘A’ if 
command code equal ‘70’. 

100163-Status Code must be BX0, BA0, 
or VF0 for A-action XRAY. 

 Action Code ‘S’. 100164-Status Code must be 1S0, 2S0, 
3S0, or 4S0 for S-action XRAY. 

 Status Code must be in AIRRS database. 100165-Status Code not found in status 
code table. 
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XRAY Data Element Validation Error Message 
 Action Code ‘L’. 100166-Status Code must be equal to 

prior status code for Action Code ‘L’ 
100167-Status Code not valid for Action 
Code ‘L’ XRAY after end of period. 

 Action Code ‘E’. 100168-Status Code first char. must be E, 
F, or J for E-action XRAY. 

 Action Code ‘F’. 100169-Status Code first char. must be 
D, E, M, N, P, or W, or code must be 
S20, S30, S40, or R00 for F-action 
XRAY. 

 Action Codes ‘G’ & ‘H’. 100170-Status Code first char. must be A 
and third char. must be 0 for G- or H-
action XRAYs. 

PERIOD Action Codes ‘M’ or ‘X’. 100180-Period cannot be equal to the 
previous XRAY period for Action Code 
‘M’ or ‘X’. 

 Inspection Types ‘C’ or ‘F’ and Action Code is 
not ‘X’ or ‘M’. 

100182-Period must be 000 or blank for 
this Action Code. 

 Status Code begins with ‘T’ or ‘U’. 100183-Period must be 000 for this 
Status Code. 

 Period must be numeric. 100184-Period must be numeric. 
 Action Code ‘G’ or ‘X’ (if reporting a change in 

Period). 
100185-No period data on file for this 
BUNO in pltfm_periods table. 

 Action Codes; ‘E’, ‘F’, ‘L’,‘R’ & ‘S’. 100186-Period must be equal to latest 
posted XRAY Period for Action Codes E, 
F, R, S, L. 

 Action Codes ‘G’ or ‘H’. 100187-Period must be equal to previous 
XRAY Period + 1 for Action Codes G 
and H. 

 Action Codes other than ‘M’ or ‘X’. 100191-Period must be entered for this 
action code. 

 IMC aircraft if first reported period must match 
with IMC Table. 

100601-Period Number must match 
Period Number in database for IMC 
aircraft. 

 Current reported Period to previous reported 
period. 

100701-Period does not match last 
reported period. 

PERIOD END 
DATE 

PED must be numeric. 100201-PED must be numeric. 

 PED must be 6 digits. 100202-PED length must be 6 digits 
long. 

 Action Codes ‘A’ or ‘S’ for non-PACE aircraft. 100203-PED cannot be 0 for Action 
Code S or A or for non-PACE aircraft. 
100204-PED is not a valid Date Format 
‘YYYYMM’. 
100205-PED must be equal to year and 
month of Action Date. 
100206-PED must be equal to Prior PED 
for this Action Code. 
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XRAY Data Element Validation Error Message 
 PACE or PDM and Drone or Experimental 

aircraft. 
100207-PED must be equal to 000000 for 
PACE and PDM aircraft and Drone and 
Experimental aircraft. 

 Validation takes non-aging into account. 
(Override error if PED is reported correctly). 

100208-Reported PED not equal to PED 
calculated by system. 

 Inspection Type change. 100298-PED must be entered for this 
action code. 

 Inspection type change. 100298-PED must be entered for this 
action code. 

 PED input format must be DD-MON-YYYY. 100299-Prior PED is invalid date format. 
 PED output format must be YYYY-MM-DD. 100300-PED must be of the format 

‘YYYYMMDD’. 
 Action Code ‘H’. 100527-Period End Date (PED) must 

equal Action Date plus Operating Service 
Period Months for aircraft’s TMS on H-
action XRAYs. 

EXTENSION Must be 2 digits. 100231-Extension Number cannot be 
more than 2 digits for Action Codes L,M, 
R, or X. 

 Action Codes; ‘A’, ‘E’, ‘F’, ‘G’, ‘H’ or ‘S’. 100232-Extension Number must be blank 
for Action Code A, E, F, G, H or S. 

 Extension must be numeric. 100233-Extension Number must be 
numeric. 

 Extension cannot be less than previous reported 
Extension Number. 

100234-Extension Number cannot be less 
than the previous Extension Number. 

ASPA PACE Action Code ‘F’ and Period End flag is ‘TRUE’. 100209-ASPA/PACE must be blank. 
 ASPA PACE must be 6 digits. 100210-ASPA/PACE must be 6 digits 

long. 
 Action Codes; ‘A’, ‘S’, or ‘Y’. 100211-ASPA/PACE must be blank or 

must equal prior XRAY ASPA/PACE. 
 Inspection Type ‘G’ (IMC). 100214-ASPA/PACE must be equal to 

prior ASPA/PACE. 
 Action Codes ‘E’ or ‘F’. 100215-The first two positions of 

ASPA/PACE should equal 00 or second 
character must be 9. 

 Inspection Type ‘C’ (PACE). 100216-The last 4 positions of 
ASPA/PACE must be 0000 or must equal 
MMYY of Action Date. 

 Inspection Type ‘D’ (PDM). 100217-The fifth position of 
ASPA/PACE cannot equal 9. 

 Action Codes ‘E’ or ‘F’ for other than PACE or 
PDM aircraft. 

100218-The Last 4 positions of 
ASPA/PACE must be 0000. 

 Action Codes ‘G’ or ‘H’ for non-
PACE/PDM/IMC aircraft. 

100219-ASPA/PACE must be blank or 
equal to 000000. 

 ASPA/PACE must be numeric. 100221-ASPA/PACE must be numeric. 
 Action Codes ‘G’ or ‘H’ for PACE aircraft. 100222-The last 4 position of 

ASPA/PACE must be ‘MMYY’. 
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XRAY Data Element Validation Error Message 
 Action Codes ‘G’ or ‘H’ for PACE aircraft. 100223-The last 4 positions of 

ASPA/PACE must be equal to action 
date plus OSPM. 

 Action Codes; ‘M’, or ‘X’. 100225-ASPA/PACE must not be equal 
to prior ASPA/PACE for this Action 
Code. 

 Inspection Types ‘E’ or ‘F’. 100226-ASPA/PACE must be blank, NA, 
N.A., or N/A for aircraft of this 
Type/Model/Series. 

 New_pid_date set to prior + 12 months. 100227-Planned Inspection Date in Item 
L does not match calculated Planned 
Inspection Date. 

 Status Codes; G41 & G50. 100228-ASPA/PACE in progress not 
compatible with reported Status Code. 

 If period end flag is ‘TRUE’. 100559-ASPA/PACE must be blank, NA, 
N.A., or N/A for aircraft where period 
has ended and new period has not begun. 

 Inspection Type ‘G’ (IMC). 100603-First two digits of ASPA/PACE 
must be 00 for IMC aircraft. 

 Inspection Type ‘G’ (IMC). 100604-PMI/POI must exceed prior 
PMI/POI on X action XRAY for IMC 
aircraft. 

 Action Codes ‘R’ or ‘X’ Inspection Type ‘A’ 
(ASPA). 

100607-ASPA indicates ASPA deferral, 
new ped/osm must be reported. 
100702-ASPA Field does not match last 
reported ASPA. 

OSM (Operating 
Service Months) 

OSM must be 3 characters. 100301-Prior OSM must be 3 characters. 

 OSM must be numeric. 100302-Prior OSM must be numeric. 
 OSM must be 3 characters. 100303-OSM must be 3 characters. 
 OSM must be numeric. 100304-OSM must be Numeric. 
 Inspection Type ‘F’. 100305-OSM must be blank or equal to 

000. 
 Action Code ‘L’. 100306-OSM must be equal to the Prior 

OSM. 
 Action Codes; ‘E’, ‘F’ or ‘S’ or Inspection Type 

‘G’ (IMC). 
100307-OSM reported does not match 
the calculated OSM. 
100308-OSM must be blank for this 
plane and action code. 

 Inspection Type not equal to ‘C’ and Action 
Code is not ‘M’ or ‘X’. 

100309-OSM must not be blank or equal 
to 000. 

 Action Code not ‘E’, ‘F’, or ‘S’ and Period End 
Flag is not ‘TRUE’. 

100310-OSM must be equal to the Prior 
OSM and OSM must be blank or not 
equal to 000. 

 Action Code ‘A’, Drones and Experimental 
aircraft and aircraft in Status Code beginning 
with ‘T’ or ‘U’. 

100311-OSM must be 000 for this Action 
Code, Status Code, or TMS. 
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XRAY Data Element Validation Error Message 
 Action Code ‘M’. 100312-OSM cannot be blank for this 

Action Code. 
ACTION DATE Action Date must be 8 digits. 100112-Action Date must be 8 digits 

long in format YYYYMMDD. 
 Action Date format. 100113-Action Date must be of the 

format ‘YYYYMMDD’. 
 Action Date sequence. 100114-Action Date cannot be later than 

current date. 
 Action Date cannot be blank. 100115-Action Date cannot be blank. 
 Estimated Rework Completion Date compared 

to current Action Date. 
100269-Action Date of in-work XRAY 
exceeds latest Estimated Rework 
Completion Date. 

ACCEPTANCE 
DATE 

Acceptance Date format. 100151-Accept Date must be of the 
format ‘YYYYMMDD’. 

 Action Code ‘A’. 100152-Accept Date must be equal to 
Action Date for this XRAY. 

 Cmis_platform deliv_dt check. 100153-Accept Date invalid based on 
delivery date in database. 

COMMAND CODE Cannot be blank; must be valid code - 10, 11, 
20, 21, 30, 31, 40, 50, 60, 70, or 90. 

Cannot be blank. 
Invalid Command Code. 

AUDIT 
INDICATOR 

Must equal ‘A’ or ‘X’ for all input records being 
processed. 

‘A’-Audit Record. 
‘X’-XRAY Record. 

 
Table 9 identifies the various input RT-79 data elements and the corresponding validations 
performed for each. The error message resulting from each validation is also shown. 
 
COMNAVAIRFORINST 4790.2 (series) governs policy for data entry and provides specific 
guidance for each data element. 

Table 9.  RT-79 Data Elements and Validations 

RT-79 Data Element Validation Error Message 
BUNO BUNO must be in the cmis_platform table. 100402-Bureau Number (BUNO) not 

found in database. 
 BUNO, Org, Trans Date and PUC duplicate 

check. 
100410-Duplicate record found with 
same BUNO, TRANS_DATE, 
ORG_CODE, and PUC. 

TEC TEC must be in cmis_prgm_types table. 100443-No Type Equipment Code (TEC) 
data found in database. 

 TEC must begin with ‘A’, ‘K’ or ‘N’. 100444-Type Equipment Code (TEC) is 
invalid.TEC must be ‘A’,’K’ or ‘N’ in 
position 1. 

 TEC forth position must not be ‘9’. 100445-Type Equipment Code (TEC) is 
invalid. TEC must not be 9 in position 4. 

ORG CODE Organization Code must be in airrs_av_orgs 
table. 

100404-Organization Code not found in 
database. 
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RT-79 Data Element Validation Error Message 
 Trans Date must fall within the Org establish 

and disestablish dates. 
100448-Organization Code (ORG) not 
valid for reported Transaction Date. 

PUC Trans Date must fall within the PUC establish 
and disestablish dates or verify PUC/ORG 
assignment. 

100403-Permanent Unit Code (PUC) not 
found in database OR PUC/Org Code 
combination not valid. 

 Verify PUC/ORG assignment. 100405-PUC/ORG combination not valid 
as of this transaction date. 

REPORT DATE 
(TRANS DATE) 

Verify Trans Date fifth and sixth position. 100446-Transaction Date is invalid, must 
be in range of 01 thru 12 in position 1-2. 

FMC MAINT HRS Verify FMC Maint Hrs are not greater than 
hours in the month. 

100416-Full Mission Capable (FMC)-
Maintenance hours reported on all RT-
79s for this aircraft this month must be 
less than total number hours in report 
month. 

 Verify FMC Maint Hrs are not greater than EIS 
hrs. 

100417-Full Mission Capable (FMC)-
Maintenance hours must not exceed 
Equipment In Service (EIS) hours. 

PMC MAINT HRS Verify PMC Maint Hrs are not greater than 
hours in the month 

100430-Partially Mission Capable 
(PMC)-Maintenance hours reported on 
all RT-79s for this aircraft this month 
must be less than total number hours in 
report month. 

 Verify PMC Maint Hrs are not greater than EIS 
hrs 

100431-Partially Mission Capable 
(PMC)-Maintenance hours must not 
exceed Equipment In Service (EIS) 
hours. 

NMCM SCHED Verify NMC Sched Maint Hrs are not greater 
than hours in the month. 

100423-Non-Mission Capable (NMC)-
Maintenance, Scheduled hours reported 
on all RT-79s for this aircraft this month 
must be less than total number hours in 
report month. 

 Verify NMC Sched Maint Hrs are not greater 
than EIS hrs. 

100424-Non-Mission Capable (NMC)-
Maintenance, Scheduled hours must not 
exceed Equipment In Service (EIS) 
hours. 

NMCM UNSCHED Verify NMC UnSched Maint Hrs are not greater 
than hours in the month. 

100427-Non-Mission Capable (NMC)-
Maintenance, Unscheduled hours 
reported on all RT-79s for this aircraft 
this month must be less than total number 
hours in report month. 

 Verify NMC UnSched Maint Hrs are not greater 
than EIS hrs. 

100428-Non-Mission Capable (NMC)-
Maintenance, Unscheduled must not 
exceed Equipment In Service (EIS) 
hours. 

FMC SUPPLY Verify FMC Supply Hrs are not greater than 
hours in the month. 

100418-Full Mission Capable (FMC)-
Supply hours reported on all RT-79s for 
this aircraft this month must be less than 
total number hours in report month. 
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RT-79 Data Element Validation Error Message 
 Verify FMC Supply Hrs are not greater than EIS 

hrs. 
100419-Full Mission Capable (FMC)-
Supply hours must not exceed Equipment 
In Service (EIS) hours. 

PMC SUPPLY Verify PMC Supply Hrs are not greater than 
hours in the month. 

100432-Partially Mission Capable 
(PMC)-Supply hours reported on all RT-
79s for this aircraft this month must be 
less than total number hours in report 
month. 

 Verify PMC Supply Hrs are not greater than EIS 
hrs. 

100433-Partially Mission Capable 
(PMC)-Supply hours must not exceed 
Equipment In Service (EIS) hours. 

NMC SUPPLY Verify NMC Supply Hrs are not greater than 
hours in the month. 

100425-Non-Mission Capable (NMC)-
Supply hours reported on all RT-79s for 
this aircraft this month must be less than 
total number hours in report month. 

 Verify NMC Supply Hrs are not greater than 
EIS hrs. 

100426-Non-Mission Capable (NMC)-
Supply hours must not exceed Equipment 
In Service (EIS) hours. 

FLT HRS Flight Hours less than or equal to hrs in month 
minus EOS hrs check. 

100414-Flight hours must be less than or 
equal to (Hours in Month minus EOS 
Hours). 

 Flight Hours less than or equal to hrs in month 
check. 

100415-Flight Hours must be less than 
total number hours in report month. 

 Flight Hour check when EIS equals hrs in month
(this error can be overridden if aircraft did not 
fly for the month, but had EIS hrs). 

100429-Flight Hours are normally greater 
than zero when EIS equals total hours in 
month and (NMCM Scheduled + NMCM 
Unscheduled + NMCS) is less than total 
hours in month. 

NUM FLTS Number of Flights compared to Flight Hours 
reported. 

100421-Number of Flights reported does 
not agree with Flight Hours reported. 
Both must be either zero of blank, or both 
must be greater than zero. 

FLT HRS SHIP Ship Flight Hours less than or equal to hrs in 
month check. 

100440-Ship Ops Flight Hours must be 
less than total number hours in report 
month. 

 Ship Flight Hours must not be greater than 
Flights Hours reported. 

100441-Ship Ops Flight Hours must not 
exceed Flight Hours. 

NUM FLTS SHIP Number of Ship Flights compared to Ship Flight 
Hours reported. 

100438-Ship Ops Number of Flights 
reported does not agree with Ship Ops 
Flight Hours reported. Both must be 
either zero of blank, or both must be 
greater than zero. 

EIS HRS EIS cannot be greater than hours for the reported 
month (i.e., 744, 720, 696 or 672) 

100412-Equipment In Service (EIS) 
hours must be less than total number 
hours in report month. 
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RT-79 Data Element Validation Error Message 
 Sum of EIS and EOS check. 100422-Sum of Equipment In Service 

(EIS) hours and Equipment Out of 
Service (EOS) hours must be less than or 
equal to the total number of hours in 
report month. 

EOS HRS EOS cannot be greater than hours for the 
reported month (i.e., 744, 720, 696 or 672). 

100413-Equipment Out of Service (EOS) 
hours must be less than total number of 
hours in report month. 

 Sum of EIS and EOS check. 100422-Sum of Equipment In Service 
(EIS) hours and Equipment Out of 
Service (EOS) hours must be less than or 
equal to the total number of hours in 
report month. 

SCIR HRS Sum SCIR hours check. 100437-SCIR hours must exceed the sum 
of NMCM-Scheduled, NMCM-
Unscheduled, NMC-Supply, PMC-
Maintenance, PMC-Supply, FMC-
Maintenance, and FMC-Supply hours. 

INVENTORY 
CODE 

Inventory Code check. 100420-Inventory Code is invalid, must 
be 1, 2, 3, 4, 9, or A. 

CORRECTION 
CODE 

Correction Code check. 100408-Correct Code is invalid, must be 
1, 2, or blank. 

DPC Data Processing Code must be in the 
airrs_av_orgs table. 

100409-No Data Processing Code (DPC) 
found in database. 

AWAY Away Code check. 100401-Away Code is invalid. The code 
must be alphanumeric or blank. 

 
8.0 Notes 
None. 
 
9.0 Definitions, Acronyms, and Abbreviations 
This is a consolidated list of acronyms compiled specifically for AIRRS documentation. Not all 
acronyms appear in this document. 
 
Acronym Definition 
ACC Aircraft Controlling Custodian 
AEMS Aircraft Engine Management System 
AIMD Aircraft Intermediate Maintenance Department 
AIRRS Aircraft Inventory and Readiness Reporting System 
AIRS Aircraft Inventory Reporting System 
AIS Automated Information System 
AMN Aircraft Model Nomenclature 
ASPA Aircraft Service Period Adjustment 
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Acronym Definition 
ATD Acceptance Test Description 
AV3M Aviation Maintenance and Material Management 
BAI Backup Aircraft Inventory 
BUNO Bureau Number 
CAC Common Access Card 
CAGE Commercial and Government Entity 
CM Configuration Management 
CMIS Configuration Management Information System 
COMFAIR Commander Fleet Air 
CPM Computer Programmer Manual 
CSCI Computer Software Configuration Items 
CUD Compilation Unit Data 
CVW Carrier Air Wing 
DB Database 
DBA Database Administrator 
DD Data Dictionary 
DECKETR DECision Knowledge Programming for Logistics Analysis and Technical 

Evaluation (DECKPLATE) Engine Transaction Reporting 
DECKPLATE DECision Knowledge Programming for Logistics Analysis and Technical 

Evaluation 
DISN Defense Information Systems Network 
DM Data Management 
DMS Defense Message System 
DoD Department of Defense 
DON Department of the Navy 
DSF Data Services Facility 
DSN Defense Switched Network 
EIS Equipment In Service 
EOS Equipment Out of Service 
FMC Full Mission Capable 
FMCM Full Mission Capable Maintenance 
FMCS Full Mission Capable Supply 
FMS Foreign Military Sales 
FSC Federal Supply Classification 
FSP Fixed Service Period 
FTP File Transfer Protocol 
FY Fiscal Year 
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Acronym Definition 
GUI Graphical User Interface 
HTML HyperText Markup Language 
I&T Integration and Test 
I/O Input/Output 
ICAO International Civil Aviation Organization 
ID Identification 
IDE Integrated Data Environment 
IE Internet Explorer 
IIS Internet Information Services 
IMC/P Integrated Maintenance Concept/Plan 
IMD Interface Management Document 
INC Incident 
IPT Integrated Product Team 
JDBC Java Database Connection 
JRE Java Runtime Environment 
LAN Local Area Network 
LMDSS Logistics Management Decision Support System 
MC Mission Capable 
MCAPP Modification, Corrosion and Paint Program 
MTP Master Test Plan 
NADOC Naval Aviation Depot Operations Center 
NALCOMIS Naval Aviation Logistics Command Management Information System 
NALDA Naval Aviation Logistics Data Analysis  
NAMO Naval Aviation Maintenance Office 
NAMP Naval Aviation Maintenance Program 
NAS Naval Air Station 
NAVAIR Naval Air Systems Command 
NAVFLIRS Naval Flight Record Subsystem 
NAVMASSO Naval Management Systems Support Office 
NAVSEA Naval Sea Systems Command 
NAVSUP Naval Supply Systems Command 
NAVWAN Naval Aviation Wide Area Network 
NEADG Navy Enterprise Application Development Guide 
NEP Navy Enterprise Portal 
NIIN National Item Identification Number 
NMC Not Mission Capable 
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Acronym Definition 
NMCI Navy/Marine Corps Intranet 
NMCP Navy Marine Corps Portal 
NMCS Not Mission Capable Supply 
NSN National Stock Number 
O&M Operations and Maintenance 
OCD Operational Concept Description 
OOMA Optimized Organizational Maintenance Activity 
OPM Operational Procedures Manual 
OPNAV Office of the Chief of Naval Operations 
OPNAVINST Office of the Chief of Naval Operations Instruction 
OSD Office of the Secretary of Defense 
OSM Operating Service Months 
OSP Operating Service Period 
PACE Paint and Corrosion Evaluation 
PAI Primary Aircraft Inventory 
PC Personal Computer 
PDAI Primary Development/Test Aircraft Inventory 
PDM Phase Depot Maintenance 
PED Period End Date 
PID Planned Inspection Date 
PMAI Primary Mission Aircraft Inventory 
PMC Partially Mission Capable 
PMCM Partial Mission Capable Maintenance 
PMCS Partially Mission Capable Supply 
PMI Planned Maintenance Interval 
POAI Primary Other Aircraft Inventory 
POC Point of Contact 
PRN Program Release Notice 
PTA Product Test Authorization 
PTAI Primary Training Aircraft Inventory 
PUC Permanent Unit Code 
QA Quality Assurance 
QPP Quality Program Plan 
RRC Requisition Restriction Code 
RT Record Type 
RTM Requirements Traceability Matrix 
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Acronym Definition 
SALTS Streamlined Automated Logistics Transmission System 
SChgMP Software Change Management Process 
SCIR Subsystem Capability and Impact Reporting 
SCMP Software Configuration Management Plan 
SCR Software Change Request 
SDD Software Design Description 
SDLM Standard Depot Level Maintenance 
SE Support Equipment 
SEQNO Sequence Number 
SERNO Serial Number 
SID Sequence Information Data 
SPAWAR Space and Naval Warfare Systems Command 
SRS Software Requirements Specification 
SSDP Software System Documentation Plan 
STP System Test Plan 
T&E Test and Evaluation 
TC Test Case 
TEC Type Equipment Code 
TFW Task Force Web 
TM Type Model 
TM Type Maintenance Code 
TMS Type/Model/Series 
TRMS Type Commander Readiness Management System 
TYCOM Type Commander 
UIC Unit Identification Code 
UM Users Manual 
VDD Version Description Document 
VG Volume Group 
XRAY Aircraft Custody/Status Change Report 
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Appendix A. AIRRS Point of Contact 

1. Title: NAVAIR 6.8.4 Customer Support 
Phone: 800-624-6621 
Email: naldahlp@logistics.navair.navy.mil 



Seaport Contract Number N00178-05-D-4570, Task Order M803 
Users Manual for AIRRS 

Document No. 2006-SPALDING-0776 
 
 

 

A-2 
Document Version:  4.8 August 28, 2009 

For Official Use Only 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Blank Page 
 



Seaport Contract Number N00178-05-D-4570, Task Order M803 
Users Manual for AIRRS 

Document No. 2006-SPALDING-0776 
 
 

 

B-1 
Document Version:  4.8 August 28, 2009 

For Official Use Only 

Appendix B. Date Formats in Ad Hoc Windows 

Input Date 
Format 

Output Date 
Format 

Field Ad Hoc Window 

DD-MON-YYYY YYYY-MM-DD Qtr Date AIRS Histories 
DD-MON-YYYY YYYY-MM-DD Action Date AIRS Histories 
DD-MON-YYYY YYYY-MM-DD Acpt Date AIRS Histories 
DD-MON-YYYY YYYY-MM-DD Per End Date AIRS Histories 
DD-MON-YYYY YYYY-MM-DD S Avg Util Ending Date AIRS Histories 
DD-MON-YYYY YYYY-MM-DD W Avg Util Ending Date AIRS Histories 
DD-MON-YYYY YYYY-MM-DD D Avg Util Ending Date AIRS Histories 
DD-MON-YYYY YYYY-MM-DD Z Avg Util Ending Date AIRS Histories 
 YYYYMM Trans Date RT79 
DD-MON-YYYY YYYY-MM-DD Mod Date RT79 
YYYYMMDD YYYYMMDD Date of Action (Action 

Date) 
XRAYs/Audits 

YYYYMM YYYYMM Per End Date XRAYs/Audits 
YYYYMMDD YYYYMMDD Acpt Date XRAYs/Audits 
YYYYMMDD YYYYMMDD Est Rewk Comp Date XRAYs/Audits 
  Mid Term XRAYs/Audits 
DD-MON-YYYY YYYY-MM-DD Receipt Date Msg 

(NAMO NADOC receipt 
date) 

XRAYs/Audits 

YYYYMMDD YYYYMMDD Audit Report Date XRAYs/Audits 
DD-MON-YYYY YYYY-MM-DD Mod Date XRAYs/Audits 
DD-MON-YYYY YYYY-MM-DD PUC Est Date Organizations 
DD-MON-YYYY YYYY-MM-DD PUC DIS Est Date Organizations 
DD-MON-YYYY YYYY-MM-DD Begin Date Organizations 
DD-MON-YYYY YYYY-MM-DD End Date Organizations 
DD-MON-YYYY YYYY-MM-DD PUC Est Date Aircraft Custody 
DD-MON-YYYY YYYY-MM-DD PUC DIS Est Date Aircraft Custody 
DD-MON-YYYY YYYY-MM-DD Accp Date Aircraft Custody 
DD-MON-YYYY YYYY-MM-DD V to Date Aircraft Custody 
DD-MON-YYYY YYYY-MM-DD Dis Est Date Aircraft Custody 
DD-MON-YYYY YYYY-MM-DD Est Date Aircraft Custody 
DD-MON-YYYY YYYY-MM-DD Wing Begin Date Aircraft Custody 
DD-MON-YYYY YYYY-MM-DD Wing End Date Aircraft Custody 
YYYYMMDD YYYYMMDD Act Date Latest Aircraft Info/Latest Aircraft Info (Daily) 
DD-MON-YYYY YYYY-MM-DD PED Latest Aircraft Info/Latest Aircraft Info (Daily) 
DD-MON-YYYY YYYY-MM-DD Acpt Date Latest Aircraft Info/Latest Aircraft Info (Daily) 
DD-MON-YYYY YYYY-MM-DD Report Date Latest Aircraft Info/Latest Aircraft Info (Daily) 
MMYY MMYY First Phase Due IMC Data 
MMYY MMYY PED IMC Data 
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Appendix C. Ad Hoc Column Descriptions 

AIRRS Histories Ad Hoc 

Field Column Name Description 
Acc Name CMD NAME Short name of the command to which the aircraft's 

reporting custodian is assigned. 
Cmd Code CMD CODE Two-digit Command Code of the Command to 

which the aircraft's reporting custodian is assigned. 
Wing Name WING NOMEN Nomenclature of the Wing to which the aircraft's 

reporting custodian is assigned as of the end of the 
quarter for which the record is generated. 

Claimant CLAIMANT This field is no longer used. 
PUC PUC PUC of the aircraft's reporting custodian as of the 

end of the quarter for which the record is generated. 
Qtr Date REPORTING DATE Last day of the last month of the fiscal quarter for 

which the record is generated. 
Prgm Element PRGM ELEMENT This field is no longer used. 
Unit Name UNIT NAME Unit Name of the AV3M Organization of the 

aircraft's reporting custodian as of the end of the 
quarter for which the record is generated (e.g., VFA-
82, VP-26). 

Class Code CLASS CODE Indicator that depicts the major class of an aircraft 
(e.g., H = Helo, VF = Fighter). 

Subclass Code SUBCLASS CODE OPNAV Aircraft Subclass in which the TMS of this 
aircraft is included. 

Type Model TYPE MODEL TM of the aircraft for which the record is generated 
(e.g., F-14, P-3, E-2). 

Av3m Org Code AV3M ORG CODE AV3M Organization Code associated with the 
aircraft's reporting custodian. 

Plane Code PLANE CODE Unique alphanumeric identifier for each TMS. 
Amn AMN AMN a position consistent representation of the 

TMS. For example, the Type code is always in the 
same position, the model number is always three 
characters, and in the same three positions. 

Amn Modifier AMN MODIFIER This field is no longer used. 
Special Character SPECIAL CHARACTER Three-digit code representing any special 

characteristics associated with the aircraft. 
BUNO BUNO BUNO unique to the aircraft represented by the 

record. 
Type Model Series TYPE MODEL SERIES TMS of the aircraft as of the end of the quarter for 

which the record is generated (e.g., F-14D, P-3C, E-
2C). 

Action Date ACTION DATE Latest Action Date received prior to the end of the 
quarterly history generation. 

Acft Age ACFT AGE Age of the aircraft in years (rounded to the nearest 
integer). 
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Field Column Name Description 
Aspa/Pace ASPA_DSDI ASPA/PACE value from XRAY Item L applicable 

to the aircraft. 
Ext EXTENSION Operating Service Period Extension reported for the 

aircraft as of the end of the quarter for which the 
record is generated. 

Life Hrs Av3m AV3M HRS IN LIFE Hours-in-life number based on RT79 data. 
Acpt Date ACPT DATE Date of acceptance of the aircraft into the Navy 

inventory. 
BUNO Loc BUNO LOC Location of the aircraft as of the end of the quarter 

for which the record is generated. 
Per End Date PER END DATE PED reported for the aircraft as of the end of the 

quarter for which the record is generated. 
Status Code STATUS CODE Three-character Aircraft Status Code in which the 

aircraft was reported as of the end of the quarter for 
which the record is generated. 

Op Svc Per OP SVC PER Operating Service Period reported for the aircraft as 
of the end of the quarter for which the record is 
generated. 

OP SVC MNTHS OP SVC MNTHS Operating Service Months expended reported for the 
aircraft as of the Period End Date reported in the 
record. 

Life Hrs Airs AIRS HRS IN LIFE Hours in life number for the aircraft reported on 
Aircraft Accounting Audits as of the end of the 
quarter for which the record is generated. 

Op Mnths Remaining OP MNTHS REMAINING Operating Service Life Months remaining for the 
aircraft (Operating Service Life Months standard for 
the TMS minus Life Months already expended). 

Op Yrs To Retirement OP YRS TO RETIREMENT Operating Years to Retirement for the aircraft. 
Op Fy Retirement OP FY RETIREMENT Operating Fiscal Year of Retirement projected for 

the aircraft. 
Stk Dmg Cat STK DMG CAT Strike Damage Category Code (position 1 of the 

four-character Strike Damage Code), if any, 
reported for the aircraft as of the end of the quarter 
for which the record is generated. 

Stk Dmg Disposition STK DMG DISPOSITION Strike Damage Disposition Code (position 4 of the 
four-character Strike Damage Code), if any, 
reported for the aircraft as of the end of the quarter 
for which the record is generated. 

Op Svc Life Mnths OP SVC LIFE MNTHS Total months since the aircraft was accepted into the 
Naval inventory. 

Stk Dmg Cause STK DMG CAUSE Strike Damage Cause Code (position 3 of the four-
character Strike Damage Code), if any, reported for 
the aircraft as of the end of the quarter for which the 
record is generated. 

Formula Hrs In Life FORMULA HRS IN LIFE Aircraft Hours in Life reported on the most recent 
Quarterly Audit. 
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Field Column Name Description 
Audit Indicator AUDIT INDICATOR One-character code indicating that the hours-in-life 

number has been audited by the aircraft inventory 
manager responsible for the aircraft. 

Expanded Stat Cat Cde EXPANDED STAT CAT 
CDE 

Retrieved from the airrs_status table. 

Expanded Stat Cat Cde 
Counts 

EXPANDED STAT CAT 
CDE COUNTS 

This field is no longer used. 

Stk Dmg Employment STK DMG EMPLOYMENT Strike Damage Employment Code (position 2 of the 
four-character Strike Damage Code), if any, 
reported for the aircraft as of the end of the quarter 
for which the record is generated. 

S Avg Util S AVG UTIL Average aircraft utilization rate for aircraft of this 
TMS calculated using Utilization Type S 
calculation. 

S Avg Util Ending Date S AVG UTIL ENDING 
DATE 

Date of the last month in the range of months used 
in calculating the aircraft utilization rate using 
Utilization Type S calculation. 

S Engr Fy Retire S ENGR FY RETIRE Engineering fiscal year of retirement projected for 
the aircraft using type S average aircraft utilization 
rate. 

S Engr Hrs Remain S ENGR HRS REMAIN Engineering hours remaining projected for the 
aircraft using type S average aircraft utilization rate.

S Engr Mnths Remain S ENGR MNTHS REMAIN Engineering months remaining projected for the 
aircraft using type S average aircraft utilization rate.

Expanded Stat Cat Cde 
Counts E 

EXPANDED STAT CAT 
CDE COUNTS E 

This field is no longer used. 

S Engr Yrs To Retire S ENGR YRS TO RETIRE Engineering years to retirement projected for the 
aircraft using type S average aircraft utilization rate.

S Var Engr Fy Retire S VAR ENGR FY RETIRE Variant engineering fiscal year of retirement 
projected for the aircraft using type S average 
aircraft utilization rate calculated using variant 
engineering service life hours, for use in 'what is' 
analysis. 

S Var Engr Hrs Remain S VAR ENGR HRS 
REMAIN 

Variant engineering hours remaining projected for 
the aircraft using type S average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

S Var Engr Mnths Remain S VAR ENGR MNTHS 
REMAIN 

Variant engineering months remaining projected for 
the aircraft using type S average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

D Var Engr Yrs To Retire D VAR ENGR YRS TO 
RETIRE 

Variant engineering years to retirement projected for 
the aircraft using type D average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

S Engr Svc Life Hrs S ENGR SVC LIFE HRS Engineering service life hours used in calculating 
type S utilization rate based projections. 



Seaport Contract Number N00178-05-D-4570, Task Order M803 
Users Manual for AIRRS 

Document No. 2006-SPALDING-0776 
 
 

 

C-4 
Document Version:  4.8 August 28, 2009 

For Official Use Only 

Field Column Name Description 
S Var Engr Yrs To Retire S VAR ENGR YRS TO 

RETIRE 
Variant engineering years to retirement projected for 
the aircraft using type S average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

W Avg Util W AVG UTIL Average aircraft utilization rate for aircraft of this 
TMS calculated using Utilization Type W 
calculation. 

W Avg Util Ending Date W AVG UTIL ENDING 
DATE 

Date of the last month in the range of months used 
in calculating the aircraft utilization rate using 
Utilization Type W calculation. 

W Engr Fy Retire W ENGR FY RETIRE Engineering fiscal year of retirement projected for 
the aircraft using type W average aircraft utilization 
rate. 

W Engr Mnths Remain W ENGR MNTHS REMAIN Engineering months remaining projected for the 
aircraft using type W average aircraft utilization 
rate. 

S Var Engr Svc Life Hrs S VAR ENGR SVC LIFE 
HRS 

Variant engineering service life hours used in 
calculating variant type S utilization rate based 
projections. 

W Engr Svc Life Hrs W ENGR SVC LIFE HRS Engineering service life hours used in calculating 
type W utilization rate based projections. 

W Engr Yrs To Retire W ENGR YRS TO RETIRE Engineering years to retirement projected for the 
aircraft using type W average aircraft utilization 
rate. 

W Var Engr Fy Retire W VAR ENGR FY RETIRE Variant engineering fiscal year of retirement 
projected for the aircraft using type W average 
aircraft utilization rate calculated using variant 
engineering service life hours, for use in 'what is' 
analysis. 

W Var Engr Hrs Remain W VAR ENGR HRS 
REMAIN 

Variant engineering hours remaining projected for 
the aircraft using type W average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

W Var Engr Mnths Remain W VAR ENGR MNTHS 
REMAIN 

Variant engineering months remaining projected for 
the aircraft using type W average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

W Engr Hrs Remain W ENGR HRS REMAIN Engineering hours remaining projected for the 
aircraft using type W average aircraft utilization 
rate. 

W Var Engr Yrs To Retire W VAR ENGR YRS TO 
RETIRE 

Variant engineering years to retirement projected for 
the aircraft using type W average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

Z Avg Util Z AVG UTIL Average aircraft utilization rate for aircraft of this 
TMS calculated using Utilization Type Z 
calculation. 
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Field Column Name Description 
Z Avg Util Ending Date Z AVG UTIL ENDING 

DATE 
Date of the last month in the range of months used 
in calculating the aircraft utilization rate using 
Utilization Type Z calculation. 

Z Engr Fy Retire Z ENGR FY RETIRE Engineering fiscal year of retirement projected for 
the aircraft using type Z average aircraft utilization 
rate. 

Z Engr Hrs Remain Z ENGR HRS REMAIN Engineering hours remaining projected for the 
aircraft using type Z average aircraft utilization rate.

W Var Engr Svc Life Hrs W VAR ENGR SVC LIFE 
HRS 

Variant engineering service life hours used in 
calculating variant type W utilization rate based 
projections. 

Z Engr Svc Life Hrs Z ENGR SVC LIFE HRS Engineering service life hours used in calculating 
type Z utilization rate based projections. 

Z Engr Yrs To Retire Z ENGR YRS TO RETIRE Engineering years to retirement projected for the 
aircraft using type Z average aircraft utilization rate.

Z Var Engr Fy Retire Z VAR ENGR FY RETIRE Variant engineering fiscal year of retirement 
projected for the aircraft using type Z average 
aircraft utilization rate calculated using variant 
engineering service life hours, for use in 'what is' 
analysis. 

Z Var Engr Hrs Remain Z VAR ENGR HRS 
REMAIN 

Variant engineering hours remaining projected for 
the aircraft using type Z average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

Z Var Engr Mnths Remain Z VAR ENGR MNTHS 
REMAIN 

Variant engineering months remaining projected for 
the aircraft using type Z average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

Z Engr Mnths Remain Z ENGR MNTHS REMAIN Engineering months remaining projected for the 
aircraft using type Z average aircraft utilization rate.

Z Var Engr Yrs To Retire Z VAR ENGR YRS TO 
RETIRE 

Variant engineering years to retirement projected for 
the aircraft using type Z average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

D Avg Util D AVG UTIL Average aircraft utilization rate for aircraft of this 
TMS calculated using Utilization Type D 
calculation. 

D Avg Util Ending Date D AVG UTIL ENDING 
DATE 

Date of the last month in the range of months used 
in calculating the aircraft utilization rate using 
Utilization Type D calculation. 

D Engr Fy Retire D ENGR FY RETIRE Engineering fiscal year of retirement projected for 
the aircraft using type D average aircraft utilization 
rate. 

D Engr Hrs Remain D ENGR HRS REMAIN Engineering hours remaining projected for the 
aircraft using type W average aircraft utilization 
rate. 
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Field Column Name Description 
Z Var Engr Svc Life Hrs Z VAR ENGR SVC LIFE 

HRS 
Variant engineering service life hours used in 
calculating variant type Z utilization rate based 
projections. 

D Engr Svc Life Hrs D ENGR SVC LIFE HRS Engineering service life hours used in calculating 
type D utilization rate based projections. 

D Engr Yrs To Retire D ENGR YRS TO RETIRE Engineering years to retirement projected for the 
aircraft using type D average aircraft utilization rate.

D Var Engr Fy Retire D VAR ENGR FY RETIRE Variant engineering fiscal year of retirement 
projected for the aircraft using type D average 
aircraft utilization rate calculated using variant 
engineering service life hours, for use in 'what is' 
analysis. 

D Var Engr Hrs Remain D VAR ENGR HRS 
REMAIN 

Variant engineering hours remaining projected for 
the aircraft using type D average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

D Var Engr Mnths Remain D VAR ENGR MNTHS 
REMAIN 

Variant engineering months remaining projected for 
the aircraft using type D average aircraft utilization 
rate calculated using variant engineering service life 
hours, for use in 'what is' analysis. 

D Engr Mnths Remain D ENGR MNTHS REMAIN Engineering months remaining projected for the 
aircraft using type D average aircraft utilization rate.

Acft Age In Mnths ACFT AGE IN MNTHS Age of the aircraft in months as of the end of the 
quarter for which the record is generated. 

D Var Engr Svc Life Hrs D VAR ENGR SVC LIFE 
HRS 

Variant engineering service life hours used in 
calculating variant type D utilization rate based 
projections. 
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RT79 Ad Hoc 

Field Column Name Description 
Inv Code INV CODE Inventory Code. Must be 1, 2, 3, 4, or 9. 
Num Flts NUM FLTS Number of Flights during month. 
Stat Flag STAT FLAG Indicates the state of the record. 

A - Awaiting validation 
I - Invalid 
P - Valid and posted (normalized) 
W - Waiting on prior records to be validated 

Display Stat DISPLAY STAT Indicates if the records can be seen in the Summary 
screens. If the value is ‘KEEP’, the record will be visible 
in the summary screens, if the value is ‘DROP’, the record 
will not be visible. 

Ver Num VER NUM Contains either the value 1 or 2. A 1 indicates that this is 
the version of the RT79 as received directly from the user. 
A 2 indicates that this is the most recent version as 
corrected on-line. 

FMC Hrs Supply FMC HRS SUPPLY Full Mission Capable Supply Hours. 
FMC Hrs Maint FMC HRS MAINT Full Mission Capable Maintenance Hours. 
TEC TEC TEC associated with the aircraft. 
DPC DPC Data Processing Code - the organization name of the data 

services facility that processed this data. 
BUNO BUNO BUNO of the aircraft for which the RT79 data is reported. 
PMC Hrs Maint PMC HRS MAINT Partial Mission Capable Maintenance Hours. 
PMC Hrs Supply PMC HRS SUPPLY Partial Mission Capable Supply Hours. 
Trans Date TRANS DATE Transaction Date is in an YYYYMM format and the data 

in the RT79 is for the entire month shown. 
Org Code ORG CODE AV3M Organization Code reporting the data. 
Record Type RECORD TYPE The value ‘79’, indicating the record type. 
EOS Hrs EOS HRS Equipment Out of Service (EOS) Hours. 
PUC PUC Permanent Unit Code. 
Away Code AWAY CODE Away From Home Code. 
Rt79 Seqno RT79 SEQNO SEQNO portion of the trigger-assigned SEQNO/ver num 

combination serving as the primary key for this record. 
EIS Hrs EIS HRS Equipment In Service Hours. 
NMCM Unsched NMCM UNSCHED Not Mission Capable Maint Unscheduled Hours. 
SCIR Hrs SCIR HRS Subsystem Capability and Impact Reporting hours data. 
Correct Code CORRECT CODE Correct Delete Flag. This Field not currently used. 
Cmd Code CMD CODE Command code to which the aircraft’s custodian is 

assigned during the period for which the data is reported. 
NMCM Sched  NMCM SCHED Not Mission Capable Maint Scheduled Hours. 
NMC Supply NMC SUPPLY Not Mission Capable Supply Hours. 
Ship Ops Flt Hrs SHIP OPS FLT HRS Ship Operation Flight Hours. 
Ship Ops Num Flts SHIP OPS NUM FLTS Ship Operation Number of Flights. 
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Field Column Name Description 
Wing Nomen WING NOMEN Nomenclature of the Wing to which the aircraft’s 

custodian is assigned during the period for which the data 
is reported. 

Flight Hrs FLIGHT HRS Flight Hours (Total). 
Primary Op Status PRIMARY OP STATUS Operational Status Category of the aircraft’s custodian 

during the greater part of the month for which the data is 
reported. 

Mod Date MOD DATE Date of last modification of row. 
Primary Fleet Asgnd PRIMARY FLEET 

ASGND 
Fleet assigned code of Fleet to which the aircraft’s 
custodian was assigned for the greater part of the month 
for which data is reported 
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XRAYS/Audits Ad Hoc 

Field Column Name Description 
ACC ACC The name of the ACC of the reporting 

custodian. 
ACC Cmd Code ACC CMD CODE Two-character command code 

identifying the ACC to whom the 
reporting custodian (identified by PUC) 
is responsible on the action date 
reported on the XRAY or Audit. 

XRAY Ser Num SER NUM Sequentially assigned serial number 
identifying each unique XRAY as it is 
produced by the Custodian (PUC). 

Prior Ser Num PRIOR SER NUM This field is no longer used. 
PRIOR DTG PRIOR DTG This field is no longer used. 
XRAY Seqno XRAY SEQNO Trigger-assigned sequence number 

serves, along with ver num, as primary 
key of record and is referenced as a 
foreign key in many other tables. 

(B)PUC PUC PUC of the Reporting Custodian of the 
aircraft. 

(C)Date of Action ACTION DATE Date that the action being reported by 
this XRAY took place. In the case of 
the audit record, it is the action date of 
the last XRAY reported for this aircraft 
for the calendar month of the audit. 

(D)Action Code ACTION CODE Code that indicates which XRAY type 
this is, in accordance with CNAFINST 
4790.2(series).  

Local Time of Receipt TIME OF RECEIPT Local time of receipt of the aircraft at 
the new Reporting Custodian's site in 
the process of a transfer of the aircraft 
(e.g., receipt XRAY).  

(E)Acft Stat Code ACFT STAT CODE Status code assigned to the aircraft as 
defined in CNAFINST 4790.2(series). 

(A)BUNO BUNO BUNO of the aircraft against which the 
XRAY or Audit is being reported 

(G)Period PERIOD Operational Service Period under which 
the aircraft was serving at the time of 
action reported on the XRAY. 

(H)Per End Date PER END DATE The ending date of the period; the 
planned date on which the aircraft will 
either enter Standard Depot Level 
Maintenance (SDLM) or be inspected 
to have the period extended. 
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Field Column Name Description 
Ver Num VER NUM Contains either value 1 or 2. A 1 

indicates the version of the XRAY or 
Audit as received directly from the 
user. A 2 indicates the most recent 
version as corrected on-line. 

XRAY Order Num XRAY ORDER NUM Defines the order that the record 
processed in a set of XRAYs where the 
BUNO is the same and the action date 
is the same. 

(F)Type Model Series TYPE MODEL SERIES Full type model series of the aircraft on 
the date of action as reported on the 
message. 

(J)Stk Dmg Code STK DMG CODE Four-character code that refers to the 
reasons that an aircraft was stricken. A 
complete list with explanations can be 
found in the CNAFINST 
4790.2(series). 

(K)Acpt Date ACPT DATE Original date that this aircraft was 
accepted into the navy inventory. This 
date will never change, even if the 
aircraft is stricken and reinstated, or 
loaned to another country and 
reinstated. The first acceptance date 
assigned to the BUNO will remain with 
the BUNO throughout its life.  

(L)ASPA/PACE ASPA PACE Six-character code which functions 
much like the period end date for 
SDLM aircraft. The code and date 
embedded in the six-character field are 
defined in the CNAFINST 
4790.2(series).  

(M)Op Svc Mnths OP SVC MNTHS Number of months this aircraft is 
anticipated to have been operational 
when the current period end date is 
reached. 

(I)Ext Num EXTENSION Number of extensions that have been 
granted to this aircraft for the period in 
effect as of the action date.  

(N)Est Rework Complete Date EST REWORK COMPLETE DATE Date any major rework that is currently 
being performed is expected to be 
completed. Determines when this 
aircraft might again be operational and 
available for mission assignment. It is 
used for SDLM as well as other 
maintenance being performed that 
might affect mission readiness. 
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Field Column Name Description 
(O)Insvc PUC INSVC PUC PUC of any custodian who currently 

has physical custody of the aircraft but 
is not the current Reporting Custodian, 
typically when an aircraft has been 
taken to a depot for major rework but is 
not transferred to that depot via a 
receipt XRAY. 

(P)ACC Rcvd From ACC RCVD FROM The ACC of the receiving Reporting 
Custodian when an aircraft is 
transferred from one Reporting 
Custodian to another. 

PUC Rcvd From PUC RCVD FROM PUC from which the aircraft was 
received via an R, F, or G action 
XRAY. Value extracted from Item P of 
the XRAY. 

Rcvd Cmd Code RCVD CMD CODE The two-character command code of 
the ACC for the receiving Reporting 
Custodian when an aircraft is 
transferred from one Reporting 
Custodian to another. 

Stat Flag STAT FLAG Indicates the state of the record. 
A - Awaiting validation 
I - Invalid 
V - Valid 
P - Valid and posted (normalized) 
W - Waiting on prior records to be 
validated 
R - Valid but failed during 
normalization process 

(V)Location ACFT LOC Name of the location that the aircraft is 
reported to have been at the time of 
action reported on the XRAY. 

Location ICAO ACFT ICAO 4 character code established by the 
FAA. Used in conjunction with location 
name to identify a location. 

Remarks REMARKS Any remark that pertains to the action 
being reported on this XRAY. 

Correction Ind CORRECTION IND When the Fleet sends corrections to 
XRAYs or Audits, they must send two 
records to correct one original. The first 
record is a Delete, and the second 
record will be a Correct that will 
completely replace the 'deleted' record. 
This flag will be a D or a C, 
respectively for those two record types.

(R)AV3M Org Code AV3M ORG CODE RPTD This will only be reported on a 
Organization Change Location to 
identify the Org Code of a newly 
established organization to which the 
Org Code is assigned. 
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Field Column Name Description 
(U)Mid Term MID TERM Number of mid-term inspections that 

have been performed on this aircraft 
during the period in place at the time of 
action. 

(T)Fleet Asgn Code FLEET ASGN CODE Only reported on a Organization 
Change Location. This will show the 
Fleet code to which the organization 
identified by PUC now reports. 

Unit Loc From UNIT LOC FROM Only used in the Organization Change 
Location being used to report a change 
of location of the unit (squadron). 
Shows the location of departure to 
allow validation that no location change 
XRAYs were skipped in processing. 

Unit Icao From 
 

UNIT ICAO FROM Only used in the Organization Change 
Location being used to report a change 
of location of the unit (squadron). 
Shows the ICAO code of the location 
of departure to allow validation that no 
location change XRAYs were skipped 
in processing.  

Unit Loc To UNIT LOC TO Only used in the Organization Change 
Location being used to report a change 
of location of the unit (squadron). 
Shows the location of arrival for this 
unit. 

Unit Icao To 
 

UNIT ICAO TO Used only on the Organization Change 
Location for a unit location change. 
This shows the ICAO code of location 
of arrival for the unit. 

(S)Op Stat Cat Code OP STAT CAT CODE Only reported on a Organization 
Change Location. This code shows the 
status of a Reporting Custodian 
(squadron or depot) as of the date of 
action on the XRAY. 

Acft Hrs Per ACFT HRS PER Number of flight hours flown on this 
aircraft during the audit period. This is 
only used in Audits. 

Acft Hrs In Life ACFT HRS IN LIFE Number of total flight hours that this 
aircraft has flown during its life. This is 
only used in Audits.  

Receipt Date Msg NAMO NADOC RECEIPT DATE Date the record was actually received 
by AIRRS.  

OOMA Extract Dt NALCOMIS RECEIPT DATE Date the record was actually received 
by AIRRS from OOMA. 

Display State DISPLAY STATE Indicates if the record can be seen in 
the Summary screens. If the value is 
‘KEEP’, the record will be visible in 
the summary screens; if the value is 
‘DROP’, the record will not be visible. 
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Field Column Name Description 
Audit Indicator AUDIT INDICATOR Indicates if the record is an XRAY or 

an AUDIT. It will have a value of A if 
it is an Audit or a value of X if it is an 
XRAY.  

Audit Report Date AUDIT RPT DATE YYYYMMDD from Line 1 of Aircraft 
Accounting Audit Report. 

Msg DTG DATE TIME GROUP Date time group of the XRAY or 
AUDIT message. 

Mod Date MOD DATE Date of last modification of row. 
Total Rec Process TOTAL REC PROCESS Indicates the total number of records 

processed. 
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Organization Ad Hoc 

Field Column Name Description 
Command Name CMD NAME SHORT Shortened version of the organizations name, suitable 

for displaying on a screen or printing on a report 
where space is a concern. 

PUC PUC Permanent Unit Code of the Squadron. The code 
through which all aircraft reporting to the ACC is 
done.  

PUC Est Date PUC EST DATE Date the PUC was established by OPNAV and 
assigned to this squadron. 

PUC DIS Est Date PUC DIS EST DATE Date this squadron or detachment can no longer use 
this PUC to report aircraft activity. Generally the date 
the organization is disestablished. 

Unit Name UNIT NAME SHORT Short version of Unit Name of AV3M Organization 
Code associated with PUC of aircraft's reporting 
custodian. 

Command Code CMD CODE Two-character code that uniquely identifies an ACC. 
The complete list can be found on pages 2 through 11 
of the CNAFINST 4790.2(series). 

Begin Date BEGIN DATE Date that the squadron begins responsibility of the 
Wing command. 

End Date END DATE Date that the squadron is no longer the responsibility 
of the Wing command. Since a squadron is not 
required to belong to a Wing, it is not sufficient to use 
the begin date of the next Wing assignment to 
determine the end of this Wing assignment because 
there may be a gap in Wing assignments. 

Control Code CONTROL CODE Two-digit code that identifies whether the Wing serves 
as a Primary COMFAIR, Secondary COMFAIR, or 
CVW. 

AV3M Org Code AV3M ORG CODE Code assigned within the AV3M system to 
differentiate one organization with aircraft 
responsibilities from another. 

Wing Nomen WING NOMEN The long name of the Wing. 
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Aircraft Custody Ad Hoc 

Field Column Name Description 
Cmd Name Short CMD NAME 

SHORT 
Abbreviated name of parent command of aircraft's reporting 
custodian. 

PUC Est Date PUC EST DATE Establishment date of PUC of aircraft's reporting custodian. 
PUC Dis Est Date PUC DIS EST 

DATE 
Disestablishment date of PUC of aircraft's reporting custodian. 

BUNO BUNO Bureau Number (BUNO) of aircraft as assigned by Office of the 
Chief of Naval Operations. 

Accp Date ACCP DATE Date of acceptance of aircraft into custody of aircraft's reporting 
custodian. 

Cmd Code CMD CODE Two-digit command code of parent command of aircraft's reporting 
custodian. 

AV3M Org Code AV3M ORG 
CODE 

AV3M Organization Code associated with Permanent Unit Code 
(PUC) of aircraft's reporting custodian. 

Unit Name Long UNIT NAME 
LONG 

Long version of Unit Name of AV3M Organization Code associated 
with PUC of aircraft's reporting custodian. 

Unit Name Short UNIT NAME 
SHORT 

Short version of Unit Name of AV3M Organization Code associated 
with PUC of aircraft's reporting custodian. 

PUC PUC PUC of aircraft's reporting custodian. 
Unit Id Code UNIT ID CODE Unit Identification Code (UIC) of AV3M Organization Code 

associated with PUC of aircraft's reporting custodian. 
V To Date V TO DATE Date of transfer of aircraft out of custody of reporting custodian. 
Dis Est Date DIS EST DATE Disestablishment date of AV3M Organization Code associated with 

PUC of aircraft's reporting custodian. 
Cmd Seqno CMD SEQNO Foreign key reference to the SEQNO of the AIRRS CMDS table 

entry of parent command of aircraft's reporting custodian. 
Org Seqno ORG SEQNO Foreign key reference to SEQNO of AV3M Organization Code 

entry in AIRRS AV ORGS table. 
PUC Seqno PUC SEQNO Foreign key reference to SEQNO of PUC's entry in AIRRS CUSTS 

table. 
Est Date EST DATE Establishment date of AV3M Organization Code associated with 

PUC of aircraft's reporting custodian. 
Wing Func WING FUNC Function code of parent Wing of aircraft's reporting custodian. 
Wing Begin Date WING BEGIN Date of beginning of relationship of AV3M Organization code of 

aircraft's reporting custodian with its parent Wing. 
Wing End Date WING END Date of ending of relationship of AV3M Organization code of 

aircraft's reporting custodian with its parent Wing. 
Wing Nomen WING NOMEN Nomenclature (name) of parent Wing of aircraft's reporting 

custodian. 
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Acft Latest Info Daily Ad Hoc 

Field Column Name Description 
(B)PUC B PUC PUC of aircraft's reporting custodian. 
(C)Actdate C ACTDATE Last Action Date posted from an XRAY. 
(D)Actcode D ACTCODE Last Action Code posted from an XRAY. 
(E)Status E STATUS Last Aircraft Status Code posted from an XRAY. 
(A)BUNO A BUNO BUNO of aircraft. 
(G)Per G PER Last Operating Service Period number posted from 

an XRAY. 
(H)PED H PED Last Period End Date (PED) posted from an 

XRAY. 
(I) Ext I EXT Last Period Extension number posted from an 

XRAY. 
(J)Stk Dmg Code J STKDMGCODE Last Strike/Damage Code posted from an XRAY. 
(F)TMS F TMS Type/Model/Series designation of aircraft. 
(L)Aspa/Pace L ASPAPACE Last ASPA/PACE posted from an XRAY. 
(M)OSM M OSM Last Operating Service Months (OSM) posted from 

an XRAY. 
(N)ECD N ECD Last Estimated Rework Completion date posted 

from an XRAY. 
(P)Unit Rcvd P UNIT RCVD Last Unit Received From posted from an XRAY. 
(K)Acpt Date K ACPT DATE Last acceptance date posted from a receipt-action 

XRAY. 
TEC TEC TEC of aircraft. 
Cmd Code CMD Command Code of addressee of last posted XRAY.
Cmd Short Name CMD NAME SHORT Short Command Name of addressee of last posted 

XRAY. 
Unit Short Name UNIT NAME SHORT Short Unit Name of aircraft's reporting custodian. 
Serial Number SER NUM Serial Number of latest XRAY reported. 
Fleet Asgn Code FLEET ASGN CODE Last Fleet Assigned Code of aircraft's reporting 

custodian. 
Class CLASS DESC The name of the OPNAV-assigned aircraft class of 

which the aircraft is a member by virtue of its TMS.
Wing Nomen WING NOMEN Name of Wing to which aircraft's reporting 

custodian is assigned. 
Hrs In Life AIRS HRS IN LIFE Last Hours in Life reported for the aircraft on an 

Audit. 
Op Stat Cat Code OP STAT CAT CODE Last Operating Status Category Code of aircraft's 

reporting custodian. 
Remarks REMARKS Remarks from last posted XRAY. 
Class Desk Remarks CLASS DESK REMARKS Any class desk remarks associated with aircraft. 

(Not used) 
Class Desk Code CLASS DESK CODE Class Desk code associated with aircraft. (Not 

used.) 
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Field Column Name Description 
Class Desk Name CLASS DESK NAME Class Desk name associated with aircraft. (Not 

used.) 
Type Model TYPE MODEL Type/Model (TM) of aircraft. 
Org Code ORG CODE AV3M Org Code of aircraft's reporting custodian. 
Report Date REPORT DATE Date on which table contents were generated. 
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AIRRS PLTFM IMC DATA 

Field Column Name Description 
Baseline Op Svc Period BASELINE OP 

SVC PERIOD 
Operating Service Period number calculated for aircraft by 
AIRRS based on number of Modification, Corrosion and 
Paint Program (MCAPP) inductions previously reported on 
XRAYs. 

BUNO BUNO Bureau Number of the aircraft. 
Baseline Op Service Months BASELINE OP 

SERVICE 
MONTHS 

OSM number calculated for aircraft by AIRRS based on 
delivery date and planned Period End Date. 

First Phase Due FIRST PHASE 
DUE 

MMYY of scheduled first induction into PMI 1. 

Location LOCATION Location of the aircraft. 
CV Or Land CV OR LAND Carrier- or land-basing of the aircraft determines length of 

IMC Fixed Service Period (FSP). 
Pltfm Seqno PLTFM SEQNO Foreign key reference to row in cmis platform containing 

BUNO of aircraft for which info is stored. 
PMI Number PMI NUMBER Number of the first PMI scheduled for the aircraft. 
PED PED PED planned for the aircraft. 
TYCOM TYCOM TYCOM in custody of the aircraft. 
Type Model Series TYPE MODEL 

SERIES 
TMS of aircraft identified by BUNO. 

PMI2 Location PMI2 
LOCATION 

Location at which Planned Maintenance Interval (PMI) 2 
will take place. 
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